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How MyAssistant Works 
 

 

MyAssistant monitors for specific situations based on your information in Sage and 

automatically informs someone. This can be as simple as sending someone a list of Jobs that 

haven't been billed in a number of days, or an AR aging spreadsheet to the people who need 

to know. MyAssistant automatically provides information to the people who need it to help 

run the business. 

 

MyAssistant uses automated processes called "Tasks" to monitor specific information in Sage 

and notify someone via email. Tasks tell the software what to look for, who to email and 

what you want to send them. 

 

Running Tasks is made up of the following processes:  

1. A Task runs (either by a Schedule or being manually triggered by a user) 

2. MyAssistant looks up specific information in Sage that meets the criteria specified in 

the Task's Condition.  

 

Example: A Task can look for Vendors with Expiring insurance 

 

3. When the specified information is found, MyAssistant determines if emails need to be 

sent and creates as many messages as needed (based on the Recipients). Specific 

email addresses can be entered on the Task, or MyAssistant can look up who to 

notify based on what was found.  

 

Example: MyAssistant can look up an email addresses for Vendors with expiring 

insurance and create a separate email for each one 
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4. Emails and any attachments are created by pulling information from Sage, including: 

▪ Lists & form letters in the email body are created based on the Task's setup 

▪ Spreadsheets are created if a MyAssistant Spreadsheet Template is attached 

▪ Any reports from Sage menus are generated 

▪ Documents, spreadsheets and/or text files are created from any attached 

Crystal Reports 

 

Example: MyAssistant creates a separate email with a form letter for each Vendor, 

containing only their information. 

 

5. MyAssistant sends the emails 

Please note: A Task can only send emails if: 

▪ When run, the Task finds information in Sage that matches the criteria in its 

Condition 

▪ At least one recipient is specified in Task Setup 

▪ The Task is set up to run automatically on a schedule, or is manually triggered by 

selecting it and clicking "Run and Send" 

 

 

 

Related Links 

How to Start Using Prebuilt Tasks 

Task Setup 
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How to Start Using MyAssistant 
 

 

Customers find early success with MyAssistant by starting with Prebuilt Tasks. Prebuilt Tasks 

are common things other companies have used MyAssistant to automate, and can be 

customized to meet your needs. This section will walk through how to find prebuilt Tasks 

that may interest you, turn them on, and see what kind of information you can receive. 

 

Determining What to Automate 

When trying to think of new ways for your company to use Sage MyAssistant, the first step is 

to build a list of things that you’d like to have automated.  

To help build your list, ask yourself questions like: 

▪ What do I spend time tracking down / getting from others? 

▪ What information would I like sent to me without asking for it? 

▪ What reports/emails/etc. would I like automatically sent to someone?  

 

Next, review the “MyAssistant Prebuilt Task List” to find Tasks that you'd like to try out and 

see what you can receive. 

 

Setting up the Automation (i.e. the Tasks) 

After determining what you want to automate with MyAssistant, the next step is to start 

setting up MyAssistant Tasks to perform the desired actions. 

 

How to Quickly Get Started Using MyAssistant 

Sage MyAssistant is installed with several hundred prebuilt Tasks that are ready to be used. 

As such, most Sage customers find success by starting with the following steps: 

1. Activate a prebuilt Task  

2. Send the email to yourself  

3. Make changes 

4. Re-send to yourself 

5. Repeat steps 3 and 4 until satisfied 

6. Update recipients 

Using the above steps enables you to explore and test out the MyAssistant software without 

sending anything to anyone other than yourself until you are ready. 
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How to Start 

1. Use Search: MyAssistant has 300+ prebuilt Tasks installed, so using the Search in the 

main MyAssistant window will help you look through the list quickly 

2. Select a Task that you'd like to try & click Activate 

 
 

3. Preview the Condition to make sure you're getting the information you want from the 

Task 
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4. Advance to the Email step, and type your name in the "To" line to make yourself the 

recipient 

 

5. Complete Task Setup & send yourself an email 

6. Identify any changes you want made 

7. Open the Task 

8. Go back to the Email step and make any desired changes. For example: 

▪ Add or remove columns from the list 

▪ Turn the emailed list into a spreadsheet 

▪ Attach a report 

9. Close the Task and send yourself a new email by clicking "Run and Send" 

 

 

Related Links 

Send a List of Notifications Overview 

Send a Spreadsheet Overview 

Send Reports & Documents Overview 
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Send a List of Notifications Overview 

 

 

One challenge companies face is knowing when something needs to be addressed. This 

could range from Vendors with expiring insurance, costs posted to a closed Job, or even 

missing Employee contact information. MyAssistant can send a list of the items someone 

needs to look at (i.e. "Notifications") in a timely manner.  

 

This section outlines how to create a Task to send a list of Notifications:  

 

1. Click the "New" button in the main MyAssistant window to create a new Task 

 

2. Choose what you want to send a list of (e.g. a list of Jobs) in the "Send a List of" 

selection list. 

 

3. Use a prebuilt or create a new Condition to filter your list to only the items you want 

(e.g. Jobs over budget, Jobs not billed in the past specified days, etc.)  

 

4. Create or customize the Condition (e.g. all open Jobs where the JTD Cost is greater 

than the Total Estimate) to ensure MyAssistant is looking for what you want 

 

 

5. Specify whether the Task should run on a Schedule  

 

6. Update the columns in the table at the bottom of the Email step -- this controls what 

Sage information is included in the emailed list.
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7. Specify the recipients that should be informed when then Condition is met. An Email 

Directory can be used to send each recipient a list of only their items (e.g. send each 

Project Manager only their Jobs).  

 

8. Confirm your settings in the Options step 

 

 

Related Links 

What to Send - Send a List of Notifications 

Email a List of Notifications  
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Send a Spreadsheet Overview 

 

 

Many people like to receive information in an Excel spreadsheet. Any information in Sage can 

be sent in a spreadsheet using MyAssistant. Examples include AR Aging Spreadsheets, Job 

Cost Breakdown spreadsheets, and AP cash flow spreadsheets. Spreadsheets can be added 

to MyAssistant Tasks using Spreadsheet Templates, which define the spreadsheet's content 

and layout. 

 

This section outlines how to create a Task to send a Spreadsheet: 

 

1. Click the "New" button in the main MyAssistant window to create a new Task 

 

2. Select that you want to send a Spreadsheet, then pick what you want to send a 

spreadsheet of (e.g. a spreadsheet of AP Invoices) in the "Spreadsheet" selection list. 

 

3. Use a prebuilt or create a new Condition to filter your spreadsheet to only the items 

you want (e.g. AP Invoices not fully paid, AP Invoices open for a specified number of 

days, AP Invoices over a specified dollar amount, etc.)  

 

4. Create or customize the Condition (e.g. AP Invoices not fully paid with an invoice date 

more than 30 days ago) to ensure MyAssistant is looking for what you want 

 

 

5. Specify whether the Task should run on a Schedule  

 

6. Update the columns in the table at the bottom of the Email step -- this controls what 

Sage information is in the spreadsheet. 
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7. Create and save a spreadsheet template using the columns in the Email step.  

 

8. Specify the recipients that should be informed when then Condition is met. An Email 

Directory can be used to send each recipient a list of only their items (e.g. send each 

Project Manager only their Jobs).  

 

9. Confirm your settings in the Options step 

 

Related Links 

What to Send - Send a Spreadsheet 

Email a Spreadsheet  
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Send Reports & Documents Overview 

 

 

Providing each person reports and documents (e.g. pay stubs) with just their information is 

time consuming.  MyAssistant Tasks can be used to automatically generate and send AR 

Aging, cost and forecasting reports filtered for each project manager; employees their pay 

statements, vendors their electronic payment notices, and more. MyAssistant can also 

automatically generate and send almost any report on a Sage reports menu. 

 

 

This section outlines how to create a Task that sends each recipient reports & documents 

with only their information: 

 

1. Click the "New" button in the main MyAssistant window to create a new Task 

 

2. Select that you want to send each person their report or document, then pick what 

information you want to use to create a mailing list (e.g. a mailing list based on PR 

Checks in order to send pay stubs). 

 

3. Use a prebuilt or create a new Condition to filter your mailing list to only the items 

that will give you your desired recipients (e.g. posted PR checks that use Direct 

Deposit)  

 

4. Create or customize the Condition to ensure MyAssistant is looking for what you 

want (e.g. PR Checks that aren't voided with Direct Deposit amounts, are from the 

most recent pay period, and that are for employees with an email address) 

 
 

5. Specify whether the Task should run on a Schedule  
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6. Attach your report(s) in the Email step; filling out the report prompts so its content is 

filtered for each email 

 
 

7. Add your Email Directory to send each recipient only their documents (e.g. send each 

Employee only their pay statement).  

 

8. Confirm your settings in the Options step 

 

This section outlines how to create a Task that sends every recipient reports & documents 

with the same information: 

 

1. Click the "New" button in the main MyAssistant window to create a new Task 

 

2. Select that you want to send each person their report or document, then pick what 

information you want to use to create a mailing list (e.g. a mailing list based on PR 

Checks in order to send pay stubs). 

 

3. Specify whether the Task should run on a Schedule  

 

4. Attach your report(s) in the Email step and fill out any prompts 

 

5. Specify the recipients that should be emailed the report(s) 

 

6. Confirm your settings in the Options step 

 

Related Links 

What to Send – Reports & Documents 

Email Each Person Their Reports & Documents  
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Task Setup 

 

 

MyAssistant monitors for specific situations based on your information in Sage and 

automatically informs someone using "Tasks". MyAssistant Tasks are the individual processes 

that do things like send each employee their pay stubs, notify Vendors when they have 

expiring insurance, email Customers their Service Management invoices, and more. To do 

this, each MyAssistant Task has the following parts: 

 

Condition: What MyAssistant should monitor in Sage and the criteria that information 

should meet 

Example: This Condition is looking for JC Cost Codes, and the criteria are: 

▪ Not a Group Cost Code 

▪ Not a closed Cost Code 

▪ Not on a Closed Job 

▪ The "Job-to-Date" Costs on a Cost Code are more than $500 over the "Total 

Estimate" 

 
Related: Conditions 
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Sage Data Folders: If MyAssistant is monitoring multiple Sage data folders, you'll choose 

which data folders the Task will look through. 

 
 

Schedule: A schedule sets if and when a Task should automatically check Sage for 

information. 

Recipients/Email Directories: Specifies who should be emailed when the Task finds 

information that matches the criteria in the "Condition". Recipients can be specified by 

entering their email addresses on the Task, or MyAssistant can look up who to notify based 

on the information found.  

Email: Controls what the recipients are sent when the Condition's criteria are met. Emails 

can have attachments like: 

▪ Attached Reports or Documents: Recipients can all be sent the same document with 

the same information, or each recipient can be sent only the information that pertains to 

them. For example: one Task can send all the manager the same cost report, while 

another Task can send each employee their weekly pay stub. 

 

▪ Spreadsheet Template: Used to send an Excel spreadsheet attached to the email(s) sent 

by the Task. A spreadsheet template specifies what Sage information will be included in 

the spreadsheet and the spreadsheet's layout; regardless of how much information is 

found. 
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What to Send 
 

 

To help users better understand the link between what they send from a Task and how it's 

set up, creating a new MyAssistant Task starts with identifying what you want to send.  

 

 

This selection changes what you see in MyAssistant in order to help you understand what 

your choices mean. 

When you click the dropdown, you can select from the following options: 

List of Notifications: This option is for sending a list of information in the body of an email. 

Options include  

 

Once this option has been selected, the next step will be to pick what the Task will send a list 

of in the body of the email. 
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Spreadsheet: Used to send an Excel spreadsheet attached to the email(s) sent by the Task.  

 

After selecting this option, the next step is to decide what you want one line per in your 

spreadsheet. 

 

Report attached as a PDF: This is used to send reports where every recipient gets the same 

information.  

 

Each person their report or documents: This option is used to send each recipient only 

their information. The next step after picking this option would be to identify what Sage 

information will be used to create a mailing list that will identify who needs to be emailed 

and who doesn't. 
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Send a List of Notifications 
 

 

To send a list of information in an email like the one pictured below, select "List of 

Notifications" in the "What would you like to send" dropdown.  

 

 

Next, click the field next to "Send a list of" and pick what Sage information you want to send 

in a list. For example, to send a list of Commitments recently set up in Sage, select "JC 

Commitment" from the "Send a list of" dropdown.   

 

Tip: Use the Search at the top and the "Frequently Used" group to quickly find what you 

want to send. 

 

You'll next select a Condition, which is the criteria that filters your list to only the items you 

want. MyAssistant comes with hundreds of "prebuilt" Conditions to customize, and the list 

will automatically filter to only those creating a list of the same items (e.g. Jobs, 

Commitments, etc.).  
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Example: If you chose to send a list of "JC Jobs", the list will show only Conditions that also 

create a list of Jobs: 

 
 

 

Note: If you are activating a prebuilt Task or modifying a Task that has already been 

activated, you cannot change what you're sending a list of 

 

 

Select a prebuilt Condition or "NEW CONDITION", then click Next. You'll then customize and 

preview your criteria in the Condition step. 

 

Related Links 

Send a List of Notifications Overview 

Email a List of Notifications 
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Send a Spreadsheet 
 

 

To send a spreadsheet attached to an email, select "Spreadsheet" in the "What would you 

like to send" dropdown.   

 

Next, click the field next to "Spreadsheet of" and pick what Sage information you want to 

send in a list. For example, to send a list of Commitments recently set up in Sage, select "JC 

Commitment" from the "Send a list of" dropdown.  

 

 

Tip: Use the Search at the top and the "Frequently Used" group to quickly find what you 

want to send. 

 

You'll next select a Condition, which is the criteria that filters your list to only the items you 

want in the spreadsheet. MyAssistant comes with hundreds of "prebuilt" Conditions to 

customize, and the list will automatically filter to only those creating a list of the same items 

(e.g. Jobs, Commitments, etc.).  
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Example: If you chose to send a spreadsheet of "JC Jobs", the list will show only Conditions 

that also create a list of Jobs: 

 
 

Note: If you are activating a prebuilt Task or modifying a Task that has already been 

activated, you cannot change what you're sending a spreadsheet of 

 

 

Select a prebuilt Condition or "NEW CONDITION", then click Next. You'll then customize and 

preview your criteria in the Condition step. 

 

Related Links 

Send a Spreadsheet Overview 

Email a Spreadsheet 
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Send a Report as a PDF 
 

 

Report attached as a PDF: This is used to send reports where the recipients are the same 

every time the Task is run, and every recipient gets the same information. If this option is 

selected, the Condition will be automatically selected and the next step will be scheduling 

the Task. 

 

 
 

Related Links 

Send Reports & Documents Overview 

 

 

 

 

 

Each Person Their Report or Documents 
 

 

Each person their report or documents: This option is used to send each recipient will only 

get their information. The next step after picking this option would be to identify what Sage 

information will be used to create a mailing list that will identify who needs to be emailed 

and who doesn't. 

 

Click the field next to "Mailing list based on" and pick what Sage information you want to 

use. For example, to send each employee their pay statement, select "PR Check" to create a 

mailing list of who was paid in the most recent pay period.   
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Tip: Use the Search at the top and the "Frequently Used" group to quickly find what you 

want to send. 

 

You'll next select a Condition, which is the criteria that filters your mailing list. MyAssistant 

comes with hundreds of "prebuilt" Conditions to customize, and the list will automatically 

filter to only those that can create a mailing list based on the same information (e.g. Jobs, 

Commitments, etc.).  

 

Example: If you chose to send a list of "JC Jobs", the list will show only Conditions that also 

create a list of Jobs: 

 
 

Note: If you are activating a prebuilt Task or modifying a Task that has already been 

activated, you cannot change what creating a mailing list based on 

 

 

Select a prebuilt Condition or "NEW CONDITION", then click Next. You'll then customize and 

preview your criteria in the Condition step. 

 

Related Links 

Send Reports & Documents Overview 

Send Each Person Their Information 
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Conditions 
 

 

MyAssistant monitors for specific situations based on your information in Sage and 

automatically informs someone using "Tasks". The Condition is the part of a Task that 

controls what MyAssistant looking for in Sage (e.g. PR Checks, JC Jobs, AP Invoices, etc.). The 

Condition also is the criteria used to only find the specific items you want. Once a Task finds 

the information that meets the criteria set in the Condition, it will use that information to 

create the email(s) and any attachments sent by the Task. When running a Task to send each 

person only their information, the Condition will also help determine who should be emailed 

and who shouldn't. 

 

You can customize a prebuilt Condition (or start with a new Condition) selected in the What 

to Send step of Task Setup. 

 

The Condition is made up of one or more logical statements that are true or false. For 

example: 

To See MyAssistant Condition 

Jobs that are over-budget 
JC Jobs with a Total Estimate greater than the Job-to-

date Costs 

Subcontractors who don't have a 

signed contract 

JC Commitments where the "Signed Received" box isn't 

checked and the Vendor's Type is "Subcontractor" 

AP Invoices Coded to a JC Jost 

Code without an Estimate 

AP Invoice Distributions where the associated JC Cost 

Code's "Total Estimate" is zero 

Which employees should be sent a 

pay stub this pay period 

PR Checks with a period end date in the last week and 

a Direct Deposit amount greater than zero 

 

Condition Parts 

Each line of a Condition contains the following pieces: 

Sage field/MyAssistant Formula: The information from a Sage field or a MyAssistant 

Formula. Examples include: 

▪ Employee's Email Address  

▪ Invoice Date on an AR Invoice  

▪ Last time a Job was billed 
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Operands: Used to compare the different values on a line. Examples include: 

▪ Equals   

▪ Is more than specified days ago  

▪ Is greater than  

▪ Contains  

▪ Is blank  

Related: All available operands 

 

A specified value, Sage field or Formula: This is what's compared against the Sage field or 

MyAssistant Formula value in the line. This could be: 

▪ $4,000 

▪ 30 days 

▪ Accounting Date on an Invoice 

▪ Percent a category is over-budget 

 

When put together, Condition rows look like the following: 

 

 

Related: Building a Condition 
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Building a Condition 
 

 

The Condition on a Task is the criteria that filter the items you're looking for (e.g. PR Checks, 

JC Jobs, AP Invoices, etc.) to only those you want. A detailed explanation of Conditions can 

be found here. 

This section outlines how to create or update the criteria of a Condition: 

 

Selecting the Sage Field / Formula  

Click the Sage field or formula on the left side of the row to show a list of the Sage 

information and formulas available to select. Expand the group that matches what you're 

looking for, then select the field to use in the row: 

 

 



_______________________________________________________________________________________________________________________________________ 

Copyright © 2022 Innovative Software Design 27 

Tip: Use the search bar at the top of the Sage field list to quickly 

find the Sage field to use in the row: 

 

 

 

Select the Operand 

Click the "=", "begins with", or whatever symbol is between the Sage field or Formula and 

the space to put the value to check against. The list of available operands will change based 

on what kind of information is being looked up (i.e. text in a field, a number like a dollar 

amount, or a date) 

 

Related: All available operands 
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Specify the field or Enter a Value 

Enter the value or select the Sage field or formula you want to compare against the first Sage 

field or formula selected. 

Click "Enter a value" to type in or select the value to check against the field: 

 

To select a Sage field or formula: click the pencil icon, click the field & choose the correct 

Sage field or formula from the list: 
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Add a row 

Adding rows to a Condition add additional criteria that the information in Sage has to meet 

to be included in the Task.  

To add a row to a Condition, click "Add Row" in the button bar at the top: 

 

Use the previous steps to modify the newly added row 

 

Add a group 

When creating or modifying a Condition, you can add groups to combine or change optional 

and required criteria. For more information on Groups, click here. 
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Condition Groups 
 

 

Task Conditions contain one or more Groups that determine whether all or some of the 

criteria need to be met. There are two types of Groups: 

"AND" Groups: All criteria in the group must be met 

"OR" Groups: One of the criteria in the group must be met 

For Example: 

▪ Checking for current employees in multiple ways: An employee's Termination Date is 

blank, or their Termination Date is before the date entered in the Rehire Date field in 

PR Employee Setup 

▪ Checking for insurance information that was never entered, is expired, or is expiring 

soon: The General Liability "Ins Proof Req" checkbox in AP Vendor Setup is checked, 

and either the insurance expiration date is blank or the expiration date is in the next 

30 days or older 

Add or Change Groups 

Click "Add Group" at the top of the screen to add a group to the end of your Condition.  

 

 

In addition to the group, the first line under the group is automatically added. You can 

change this line using the options outlined in Building a Condition. 
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To change a group, click the "AND" or the "OR" above the lines of the Condition that you 

want to change, then select what you want to change it to: 

 

 

Tip: Add groups to the end of a Condition to help stay organized as to what criteria is 

falling under which group. It's technically possible (though not advised) to have criteria from 

an outer group under an inner group, but always putting groups at the end of your criteria 

ensures conditions are easy to read. 

 

Understanding Groups 
Criteria will always be indented under the group's heading, which most of the time will be an 

"AND" or an "OR" heading. 

 

"AND" group only 

If your condition only has several rows grouped under an "AND", the information being 

looked up in Sage must meet the criteria on every line in order to be included on an emails 

or attachments being sent by the Task: 

 

 
What this means: This Condition is only looking for Jobs in Sage that meet all of its criteria: 

▪ The Job's Status field is "In progress", and 

▪ The Project Manager field on the Job is not blank, and 

▪ The Total Estimate on the Job is greater than or equal to $50,000 
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If a Job did not meet all criteria, it would not be included in any emails or attachments sent 

by the Task. 

 

"OR" group only 

If your condition only has several rows grouped under an "OR", the information being looked 

up in Sage needs meet the criteria at least one of the lines in order to be included on an 

emails or attachments being sent by the Task: 

 

 
 

What this means: This Condition is looking for Employees missing address information in 

Payroll. In this case, the Condition wants to find any employees that meet one or more of the 

following criteria: 

▪ The "Address 1" field in Employee Setup is blank, or 

▪ The "City" field in Employee Setup is blank, or 

▪ The "State" field in Employee Setup is blank, or 

▪ The "Zip Code" field in Employee Setup is blank  

 

Only Employees that don't meet any of the criteria will be excluded from the emails or 

attachments sent by the Task. 

 

 

"AND" group with an "OR" group underneath 

Sometimes a condition will have several required criteria and some optional criteria, meaning 

you want to use both an "AND" and "OR" grouping. When you have an "OR" underneath an 

"AND" group, it means all the criteria outside the "OR" must be met, and at least one of the 

"OR" criteria: 
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What this means: This Condition is looking for specific Employees in Payroll. To be included 

in any emails or attachments sent by MyAssistant, an Employee must meet the first two 

criteria, and at least one of the criteria under the "OR":  

▪ An Employee is in the "Field" pay group, and 

▪ The "Email Address" field in Employee Setup is blank, and 

▪ Either 

▪ The "Termination Date" field in employee setup is blank, or 

▪ The "Termination Date" field is a date before the date in the "Rehire Date" 

field 

 

Employees who do not meet the first two lines of the criteria and at least one of the criteria 

under the "OR" will be excluded in any emails or attachments sent by the Task. 

 

 

Multiple "AND" and "OR" groups underneath one another 

As you get more comfortable with creating your own Conditions, you can have multiple 

groups underneath one another. When you have multiple groups, it's important to 

remember that all the criteria that are indented at the same level are what fall under that 

group: 

 

 
 

What this means: This Condition is looking for JC Jobs. To be included in any emails or 

attachments sent by MyAssistant, a Job must meet the first two criteria, and at least one of 

the criteria under the "OR". In this case, the second "OR" option actually has two criteria that 

both must be met: 

▪ The Job's status is "In progress", and 

▪ The Total Estimate on the Job is less than $125,000; and 

▪ Either 

▪ Option 1: The "Estimator" field on the Job is blank, or 

▪ Option 2: 

▪ The "Project Manager" field on the Job is blank, and 

▪ The "Project Manager Email" field on the Job is blank 
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Operands 
 

 

The list of available operands for a row in a Condition will change depending on the type of 

information being looked up. Operands are selected as part of building a Condition. 

 

Text Operands 

These operands are available when checking text entered in Sage. Common examples 

include AP Vendor ID, AR Customer Name, PR Employee Number, and JC Job Description. 

 

Operand Definition Example 

 

The text from the field or formula to 

the left of the operand matches the 

text entered or Sage field selected on 

the right 

To see all Subcontracts: 

 

 

The text from the field or formula to 

the left of the operand doesn't match 

the text on the right 

To see Jobs where the Project Manager isn't John 

Smith: 

 

 

The text to the right of the operand is 

somewhere in the text from the field on 

the left 

To see all Commitments where "wiring" is 

somewhere in the Commitment's Description: 

 

 

The text to the right of the operand is 

not anywhere in the text from the field 

on the left 

To see AR Customers where "University" is not in 

their name: 

 

 

The text from the field or formula on 

the left starts with the text entered or 

Sage field selected on the right 

To see all Jobs that begin with the "23": 

 

 

The text from the field or formula on 

the left ends with the text entered or 

Sage field selected on the right 

To see all Commitments on Jobs that end in 

"100": 

 

 

The text to the right of the operand is 

somewhere in the text from the field on 

the left 

To see all Employees that have "Admin" 

somewhere in their title: 

 

 

The text to the right of the operand is 

not anywhere in the text from the field 

on the left 

To see all Jobs where "NYC" is not in the 

description: 

 

 

The text from the field or formula to 

the left of the operand matches one of 

the options on the right 

To see Customers with an ID of "GA","OHSU", 

"TT" or "TC": 

 

 

The text from the field or formula to 

the left of the operand doesn't match 

any of the options on the right 

To see Employees that don't have an ID of 100, 

101 or 103: 

 

 The field or formula specified is blank 
To see Employees with no Email Addresses: 

 

 The text field is not blank 

To see Employees with Email Addresses in PR 

Employee Setup: 

 

 

The text from the field or formula to 

the left of the operand doesn’t begin 

with the text entered or Sage field 

selected on the right 

To see Jobs with IDs that do not begin with "XX": 
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The text from the field or formula to 

the left of the operand does not end 

with the text entered or Sage field 

selected on the right 

To see Cost Codes that do not end in "000": 

 

 

 

Number Operands 

These operands are available when checking numbers entered in Sage. Common examples 

include the Total Estimate on a Job, the Net Pay amount on a PR Check, the number of Days 

Before Due entered in AR Customer Setup, and the number Payment Days in AP Vendor 

Setup. 

 

Operand Definition Example 

 

The number from the field or 

formula to the left of the 

operand equals the number 

entered or Sage field selected on 

the right 

To see AP Invoice Distributions with $0 paid: 

 

 

The number from the field or 

formula to the left of the 

operand doesn't equal the 

number entered or Sage field 

selected on the right 

To see Commitments where the amount 

invoiced isn't $0: 

 

 

The number from the field or 

formula to the left of the 

operand is greater than the 

number entered or Sage field 

selected on the right 

To see Cost Codes that are over-budget by 

more than five percent: 

 

 

The number from the field or 

formula to the left of the 

operand is greater than or equal 

to the number entered or Sage 

field selected on the right 

To see Commitments that are $500 or more: 

 

 

The number from the field or 

formula to the left of the 

operand is less than the number 

entered or Sage field selected on 

the right 

To see Cost Codes with revised Contract 

amounts less than $1,000: 

 

 

The number from the field or 

formula to the left of the 

operand is less than or equal to 

the number entered or Sage 

field selected on the right 

To see AP Invoices with $1,500 or less open on 

them: 

 

 

The number from the field or 

formula to the left of the 

operand is between the two 

numbers specified on the right 

To see Jobs with Total Estimates between 

$100,000 and $200,000: 

 

 

The number on the left is not 

between in the two numbers on 

the right 

To see Jobs with Revised Contracts not between 

$50,000 and $100,000: 

 

 

The number from the field or 

formula to the left of the 

operand is between the two 

numbers specified on the right 

To see Bank Accounts whose balances changed 

between $2,500 and $5,000 yesterday: 
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The text from the field or 

formula to the left of the 

operand matches one of the 

numbers on the right 

To see AP checks numbered 100251, 100257, 

100275 or 100301: 

 

 

The text from the field or 

formula to the left of the 

operand doesn't match any of 

the numbers on the right 

To see Credit Card Payments with a Payment ID 

other than 200150 or 200188: 

 

 

Date Operands 

These operands are available when checking the value of a date field. Examples include the 

Period End Date on a PR Check, the Date Issued on a Lien Waiver, the Invoice Date on an SM 

Invoice, and the Accounting Date on a JC Transaction. 

 

Operand Definition Example 

 

The date from the field or 

formula to the left of the operand 

matches the day the Task is run 

To see AP Electronic Payments with a 

Payment Date matching the day the Task 

runs: 

 

 

The date from the field or 

formula to the left of the operand 

is before the day the Task is run 

 To see Subcontracts and Purchase Orders 

(i.e. Commitments) with a date prior to the 

day the Task runs: 

 

 

The date from the field or 

formula to the left of the operand 

is after the day the Task is run 

To see AP Invoices with a "Due Back Date" 

that is after the day the Task runs: 

 

 

The date from the field or 

formula to the left of the operand 

is between the day the Task runs 

and the number of days entered 

in the future 

To see AP invoices with a discount date in 

the 15 days after the date the Task is run: 

 

 

The date from the field or 

formula to the left of the operand 

is between the day the Task runs 

and the number of days entered 

in the past 

To see Transactions with a date in the 7 

days prior to the date the Task ran: 

 

 

The date from the field or 

formula to the left of the operand 

is further in the future than the 

day the Task runs plus the 

number of days entered 

To see Jobs where the Estimated Completed 

Date is more than 90 days after the day the 

Task ran: 

 

 

The date from the field or 

formula to the left of the operand 

is further in the past than the day 

the Task runs minus the number 

of days entered 

To see AP Invoices dated more than 30 days 

before the date the Task ran: 

 

 

The date from the field or 

formula to the left of the operand 

is after the date the Task ran 

minus the number of days 

entered or in the future 

To see PR Checks with Period End Dates in 

the 6 days before the Task ran, the same 

day the Task runs, or in the future: 
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The date from the field or 

formula to the left of the operand 

is after the date the Task ran 

minus the number of days 

entered or in the past 

To see Vendors with Worker's Comp 

Insurance expiring in the 30 days after the 

Task runs, the same day the Task runs, or in 

the past: 

 

 

The date from the field or 

formula to the left of the operand 

is between the two dates entered 

or Sage fields selected on the 

right 

To see Jobs with Estimated Completion 

Dates between 6/30/2022 and 12/31/2022: 

 

 

The date from the field or 

formula to the left of the operand 

is sometime in the calendar year 

after the date when the Task is 

run 

To see PR Checks dated for the calendar 

year after the day the Task runs: 

 

 

The date from the field or 

formula to the left of the operand 

matches the date entered or Sage 

field selected on the right 

To see Vendors whose General Liability 

Insurance will expire on 12/31/2022: 

 

 

The date from the field or 

formula to the left of the operand 

doesn't match the date entered 

or Sage field selected on the right 

To see AP Invoices where the Invoice Date 

doesn't match the Accounting Date: 

 

 

The date from the field or 

formula to the left of the operand 

is after the date entered or Sage 

field selected on the right 

To see Jobs where the Last Cost Update was 

after the last time the Job was billed: 

 

 

The date from the field or 

formula to the left of the operand 

is the same day as or later than 

the date entered or field selected 

on the right 

To see PR Checks with a Period End Date 

the same day or after the Check Date: 

 

 

The date from the field or 

formula to the left of the operand 

is before the date entered or field 

selected on the right 

To see Subcontracts and Purchase Orders 

(i.e. Commitments) with dates prior to the 

date when a signed contract was received: 

 

 

The date from the field or 

formula to the left of the operand 

is the same day as or before the 

date entered or field selected on 

the right 

To see Jobs where the Actual Completion 

Date is the same day or prior to its Last Cost 

Update: 

 

 

The date from the field or 

formula to the left of the operand 

is blank 

To see AP Vendors where the Expiration 

Date for their Worker's Comp insurance has 

not been entered in Sage: 

 

 

The date from the field or 

formula to the left of the operand 

is i.e., not blank 

To see Jobs that have had overtime and 

when they had it: 

 

 

The date from the field or 

formula to the left of the operand 

is between the two dates entered 

or Sage fields selected on the 

right 

To see Credit Card payments dated 

between 12/1/2022 and 12/31/2022: 
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The date from the field or 

formula to the left of the operand 

is not between the two dates 

entered or Sage fields selected on 

the right 

To see Vendors whose most recent invoices 

were not between 1/1/2022 and 

12/31/2022: 

 

 

The date from the field or 

formula to the left of the operand 

is after the day the Task runs but 

still in the same year 

To see Cost Codes with Estimated 

Completion Dates later in the same year the 

Task was run: 

 

 

The date from the field or 

formula to the left of the operand 

is between the day the Task runs 

and 30 days in the future 

To see Employees who have an 

employment anniversary in the next 30 

days: 

 

 

The date from the field or 

formula to the left of the operand 

is between the day the Task runs 

and 7 days in the future 

To see Subcontracts and Purchase Orders 

(i.e. Commitments) with a Delivery Date in 

the next 7 days after the Task is run: 

 

 

The date from the field or 

formula to the left of the operand 

is in the year the Task runs 

To see Vendors who have been cut a check 

in the year the Task is run: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month the Task runs 

To see Jobs that last had a billing in the 

month the Task is run: 

 

 

The date from the field or 

formula to the left of the operand 

is between the day the Task runs 

and 7 days prior 

To see PR Checks with a Check Date in the 

last 7 days: 

 

 

The date from the field or 

formula to the left of the operand 

is between the day the Task runs 

and 30 days prior 

To see AP Invoices with an Accounting Date 

in the last 30 days: 

 

 

The date from the field or 

formula to the left of the operand 

is before the day the Task runs 

but still in the same year 

To Employees who were hired earlier in the 

year the Task runs: 

 

 

The date from the field or 

formula to the left of the operand 

is from before the calendar year 

when the Task was run 

To see Subcontracts and Purchase Orders 

(i.e. Commitments) with a Last Check Date 

from a year before to the year the Task is 

run:  

 

 

The date from the field or 

formula to the left of the operand 

matches the date entered or Sage 

field selected on the right 

To see AP Invoices where the Invoice Date is 

the same day as the Payment Date: 

 

 

The date from the field or 

formula to the left of the operand 

is any day in the month the Task 

was run 

To see AP Electronic Payments made in the 

same month the Task is run: 

 

 

The date from the field or 

formula to the left of the operand 

is any day in the week the Task is 

run 

To see Jobs with an Actual Start Date in the 

same week the Task is run: 
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The date from the field or 

formula to the left of the operand 

is any day in the calendar year the 

Task is run 

To see PM Leases with an Actual End Date 

in the same year the Task is run: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month after the month 

the Task is run 

To see Vendors with Auto Insurance 

expiring in the month after the month the 

Task is run: 

 

 

The date from the field or 

formula to the left of the operand 

is in the year after the year the 

Task is run 

To see Subcontracts and Purchase Orders 

(i.e. Commitments) scheduled to start in the 

year after when the Task is run: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month before the month 

the Task is run 

To see AP Checks cut in the month before 

when the Task is run: 

 

 

The date from the field or 

formula to the left of the operand 

is in the year before the year the 

Task is run 

To see Employees terminated in the year 

before when the Task is run: 

 

 

The date from the field or 

formula to the left of the operand 

is between the i.e., day the Task 

runs and the beginning of the 

year 

To see AP Invoices entered from the 

beginning of the year up to when the Task 

is run: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month of January in any 

year 

To see Employees with a birthday in 

January: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month of February in any 

year 

To see Employees that were hired in the 

month of February: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month of March in any 

year 

To see Employees with a birthday in March: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month of April in any 

year 

To see Employees that were rehired in the 

month of April: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month of May in any 

year 

To see Employees with a birthday in May: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month of June in any 

year 

To see Employees with a birthday in June: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month of July in any year 

To see Employees that were hired in the 

month of July: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month of August in any 

year 

To see Employees with a birthday in August: 
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The date from the field or 

formula to the left of the operand 

is in the month of September in 

any year 

To see Jobs completed in the month of 

September: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month of October in any 

year 

To see Employees terminated in the month 

of in October: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month of November in 

any year 

To see Employees with a birthday in 

November: 

 

 

The date from the field or 

formula to the left of the operand 

is in the month of December in 

any year 

To see Employees with a birthday in 

December: 
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MyAssistant Formulas 
 

 

Sometimes on a Task you may want to see something like: 

▪ A sum (e.g. the sum of open AP Invoices for a Vendor) 

▪ Math equations or date math (e.g. a Job's remaining budget by subtracting Job-to-

Date cost from the Total Estimate)  

▪ Looking up information not directly related to what is being found by a Task (e.g. see 

the last time a Job was billed by looking at JC Transactions) 

▪ ....and more 

These can all be done with what are called MyAssistant Formulas. MyAssistant Formulas are 

advanced ways to look up, calculate or summarize information in Sage in order to use it in a 

Task. Formulas can be used in several places throughout Task Setup, including (but not 

limited to): 

▪ On a line in a Condition to filter what information is found by Task 

▪ In the prompt field of an attached report that will change its contents 

▪ In an email subject line or message body to provide additional information 

 

Using MyAssistant Formulas in Conditions 

Using MyAssistant formulas in a Task Condition lets you use filter what's found by a 

MyAssistant Task in a way you may not have previously known was possible/how to do it. 

Examples of formulas you can use in a Task Condition include: 

▪ Sum of open AR Invoices for a Customer 

▪ Percent a Cost Code is over-budget 

▪ Last time a Job had overtime 

▪ Number of different Jobs on a Contract 

▪ Sum of all cost transactions from this month for a Job 

▪ Open amount on an AP Invoice 

Using a MyAssistant Formula in a Condition criteria lets you use potentially more complex 

criteria on a single line to find the Sage information you want. 
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Add a Formula to a Condition 

When building a Condition in Task Setup, you can add a Formula to a row by clicking the 

Sage field or formula on the left side of the row. Next, expand the "Formulas (Built-In)" or 

"Formulas (Owner)" group (depending on who created the formula) and select the formula 

to use in the row: 

 

After selecting the formula to use, select the appropriate operand and Sage field or 

number/text to check against 
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Creating your own MyAssistant Formula 

To create your own formula to use on a Condition, click "Add Formula" in the button bar: 

 

Select if you want the Formula to give you a number, text or a date; name the formula and 

create your criteria. When finished, click "Save" and close the window. 

 

Important: When you create a MyAssistant Formula, it will be linked to whatever 

information the Task is looking up. For example: if you create a new Formula on a Task that 

is sending a list of JC Jobs, the Formula will be linked to the JC Job record in Sage. This 

means you will only be able to use this Formula on Tasks that can access JC Jobs. 
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Advanced Conditions 
 

 

Advanced Conditions define what a Task is looking for in two parts: the Check All record and 

the Condition Expression. 

 

The Check All record is what you want a list of; i.e. vendors, jobs, invoices, etc. 

 

The Condition Expression is what you are looking for in that list. For example: Vendors with 

expiring insurance, Jobs that haven’t been billed in 40 days, or Customers with a balance 

over a certain dollar amount. 

 

MyAssistant comes with numerous Conditions that are predefined and ready to use in Tasks. 

To access these Conditions, go to File > Define Conditions. From the Define Condition 

dialog you can open the predefined Conditions and make copies so that you can make 

changes, or you can write your own conditions. There are also examples that show how to 

use various functions. Click here for more information on writing your own Condition. 

 

Related Topics 

Creating a New Condition 

Functions 

How to Read a Condition 

Copying Conditions 

Editing Conditions 

Deleting Conditions 

Learning Resources for Conditions 

Selecting Conditions 

Testing Conditions 
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Understanding Conditions 
 

 

MyAssistant Conditions define the situations you like monitored. The MyAssistant software 

comes with many prebuilt Conditions that can be used as-is or copied and modified. The 

following outlines how to read or interpret a condition to determine if it will meet your 

needs. 

A condition has two parts: 

• Which Sage 300 CRE database records will be checked (Check All) 

• What is checked for each record (Condition Expression) 

 

Check All 

The first step in determining if a condition will meet your needs is to check the Sage 300 CRE 

record specified in the Check All field. 

When a condition is run, MyAssistant performs the test specified in the Condition Expression 

for each occurrence of the Sage 300 CRE database record specified in the Check All field. A 

notification is created when the test is true. For example, if JC Job is select in the Check All 

field, MyAssistant will execute the test specified in the Condition Expression and create one 

notification for each job that meets the condition. 

 

Condition Expression 

The Condition Expression defines what is tested when the condition runs. The Condition 

Expression can be one or more logic statements that result in true or false. A logic statement 

can contain Sage 300 CRE database fields, specified values, functions and mathematical 

operands. Each logic statement is separated with an AND or OR operand and can be 

grouped together with parenthesis. The Condition Expression is reviewed by stepping 

through each logic statement. 

 

The following may be included in the Condition Expression: 

• Sage 300 CRE database fields – Sage 300 CRE database record / field names are 

surrounded with double quotes. They appear as "Record"."Field"; for example: 

"APM_MASTER__INVOICE"."Invoice_Date". 

• Specified Values – Specified values are formatted based the type of data. Text 

values are specified with single quotes, dates are specified with single quotes in the 

format 'YYYY-MM-DD', and numbers do not use any quotes or other symbols. 

• Functions – Functions include things such as CURDATE() to specify today's date 

and IS NULL as test for a blank date. See the Function list for a definition of each 

available function. 
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The following are a few sample logic statements that use Sage 300 CRE fields, functions, 

mathematical operators and specified values: 

 

This tests for the type being equal to Subcontractor. Use single quotes to specify the value of 

a text field: 

"APM_MASTER__VENDOR"."Type" = 'Subcontractor' 

 

This tests for the Vendor's Outstanding Amount being greater than 10000. Do not use 

quotes to specify a number: 

"APM_MASTER__VENDOR"."Outstndg_Amount" > 10000 

 

This tests whether a date field is blank: 

"APM_MASTER__INVOICE"."Invoice_Date" IS NULL 

 

This tests whether the discount date is within seven days of today: 

"APM_MASTER__INVOICE"."Discount_Date" <= CURDATE()+7 

 

This tests whether JTD Cost minus the Total Estimate is greater than or equal to 500. 

(Although 500 is a dollar amount, the dollar symbol ($) is not used): 

"JCM_MASTER__JOB"."JTD_Cost" - "JCM_MASTER__JOB"."Total_Estimate" >= 500 

 

This tests for any accounts where the first two characters on the left are 10. Since this is an 

alpha field, quotes are used around the specified value. Use the Browse Data feature to 

determine the field type: 

LEFT("GLM_MASTER__ACCOUNT"."Account", 2) = '10' 

 

This tests for an invoice date that is greater than or equal to January 15, 2005. Use single 

quotes to specify the value of a date field: 

"APM_MASTER__INVOICE"."Invoice_Date" >= '2005-01-15' 
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Creating New Conditions 
 

 

Conditions can be created while you are creating a new Task, or separately. 

To create a Condition: 

1. Select File > Define Conditions. 

2. In the Condition Name field, enter the new Condition name. Each Condition must 

have a unique name. 

3. From the Application dropdown list, select the application that contains the data 

record that MyAssistant should look through when applying this condition. Your 

selection here determines what "Check All" options are available. 

4. From the Check All dropdown list, select the record that MyAssistant should look 

through when running the condition. For example, if you would like to check each 

vendor for a specific situation, select AP Vendor. 

5. From the Category dropdown list, select the Category to which you want this 

condition added. If you wish to create a new Category, click Add. Conditions that are 

not assigned a Category are listed in a group titled Uncategorized Conditions. 

6. In the Description field, enter a description of the Condition. This description is 

displayed when you select a Condition while setting up a task. 

7. Enter your Condition statement(s) in the Condition Expression area. 

 

A Condition is a test that results in a true or false statement. A Condition can contain one or 

more expressions, connected with "AND"s and "OR"s. You can use the tree on the left to 

select database fields from the Check All record or associated records. Once a field is added 

to the Condition Expression, it will appear in a "TABLE NAME"."Field Name" format. Both the 

table name and field name are surrounded by quotes and are case sensitive. For example, 

the Accounts Payable vendor name would appear as: 

"APM_MASTER__VENDOR"."Vendor_Name" 

Often conditions check to see if something is zero or blank. Specifying that something is 

blank varies by data type:  

• Number: Enter the number zero. 

• Text: Enter two single quotes: ''. 

• Date: Use the IS NULL function. 

 

You can also enter a mathematical expression such as adding two fields together. For 

example, the following would subtract the AP tax amount from the invoice amount: 

"APM_MASTER__INVOICE"."Amount" - "APM_MASTER__INVOICE"."Tax" 
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Testing Conditions 
 

 

You can use the Test button in the Define Condition dialog to make sure you are returning 

the data that you expect. Once the test has run, the results will be displayed in a new 

window. You can change the view of the results by adding data columns or sorting the 

results by a different column. 

To add Columns to the results table: 

1. Expand a data table in the Available Columns list 

2. Select the Sage 300 CRE data field that you wish to view in the test 

3. Click on the right arrow to add the field to the list of Columns in the results. 

4. Click Update Result 

To Sort the Results by a given column, click the column header in the results pane at the 

bottom. The results will be sorted in ascending order. Click the column header again to sort 

by that column in descending order. 

If the results that you receive in the Test Condition dialog are not what you expect, verify 

that the Condition Expression is written properly. For more information, please refer to 

Understanding Conditions. 

Please note: The changes made in the test window are not applied to any task. The columns 

selected in the Test Condition dialog are used solely for that test. 

Related Topics 

Functions 

Understanding Conditions 
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Selecting Conditions 
 

 

When you click Open in the Define Condition dialog, you have a choice between User 

Conditions and Built-In Conditions. Once you have selected the condition you wish to work 

with, click OK to view the condition in its entirety. 

User Conditions 

Any conditions that you create will be saved on the User Condition tab. You will also notice 

that there are several example conditions on the User Condition tab. These examples show 

how to use various functions in the Condition Expression. 

Built-In Conditions 

MyAssistant comes with 340 prebuilt conditions. They are designed to be used right out of 

the box and can be customized during Task setup. If the prebuilt condition is close to what 

you need, but you wish to modify it slightly, this can be done by opening the condition, then 

copying it so that you can make changes. The copied condition will be saved on the User 

Conditions tab. 

Related Topics 

Creating new Conditions 

Functions 

Understanding Conditions 

  



_______________________________________________________________________________________________________________________________________ 

Copyright © 2022 Innovative Software Design 50 

Copying Conditions 
 

 

MyAssistant comes with various prebuilt Conditions. Some of these will fit your needs right 

out of the box; others will need to be modified. Prebuilt Conditions do not allow you to 

make changes, instead they must be copied, and then the copy may be modified. This way 

the original Condition is always available to reference or use. In addition, you can copy the 

conditions that you write. 

 

To copy a Condition: 

1. Click File > Define Conditions 

2. Click Open 

3. Select the Condition you would like to edit, then click OK 

4. Click Copy in the toolbar 

5. Enter a unique name for the Condition, the click OK 

6. Modify the Condition 

7. Click Save 

 

Editing Conditions 
 

 

You may edit any custom Condition. In addition, you may copy a prebuilt Condition and 

make changes to the copy. 

To edit a Condition: 

1. Click File > Define Conditions 

2. Click Open 

3. Select the Condition you would like to edit, then click OK 

 

Please note: Editing a Condition will change the Condition for all Tasks that use that 

Condition. If you don’t want all the Tasks using that Condition to be affected, copy the 

Condition and use the copy to make the changes. 

 

Related Topics 

Customizing Prebuilt Conditions 

Functions 
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Deleting Conditions 
 

 

To Delete a Condition: 

4. Make sure no Tasks are using the Condition you would like to delete 

5. Click File > Define Conditions 

6. Click Open 

7. Select the Condition you would like to delete, then click OK 

8. Click Delete in the toolbar. A confirmation message will be displayed. 

Please note: Prebuilt Conditions may not be deleted. 
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Functions 
 

 

Functions are built-in procedures or subroutines used to evaluate, make calculations on, or 

transform data. You can use one or more functions when you define a condition. 

 

IN - Test a field for multiple values 

CURDATE() - Current Date 

DAYOFMONTH() - Day of the month 

DAYOFWEEK() - Day of the week 

MONTH() - Month of the year 

YEAR() - Year 

LENGTH() - Length of text 

CONCAT() - Concatenate 

LTRIM() - Remove space characters from the left side of a text field 

RTRIM() - Remove space characters from the right side of a text field 

SUBSTRING() - Return a portion of a text field 

LOCATE() - Find a substring in a text field 

LEFT() - Display a given number of characters from the left of a text field 

RIGHT() - Display a given number of characters from the right of a text field 

CONVERT() - Convert a given field to another data type 

IS NULL/IS NOT NULL - Determine if a field is (or is not) blank 

NOT() - Switch boolean value of a field 

UCASE() - Convert text to UPPER CASE 

LCASE() - Convert text to lower case 
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IN - Test a field for multiple values 

The IN operator tests a given field against a list of values, and returns true if the field 

matches an item in the list. You can wrap an expression in the NOT() function to determine if 

a field is not one of the set of values. 

 

 Syntax: IN (comma separated list) 

 

 Examples: 

To show all GL Accounts of type Current assets and Noncurrent assets: 

"GLM_MASTER__ACCOUNT"."Account_Type" IN ('Current assets','Noncurrent assets') 

To show all GL Accounts that are not Suspense or Units accounts: 

NOT("GLM_MASTER__ACCOUNT"."Account_Type" IN ('Suspense','Units')) 

Back to Top 

 

CURDATE() - Current Date 

The CURDATE() function returns the current system date. This value can then be compared to 

other database date fields or can be part of an expression. Adding or subtracting a number 

from CURDATE() changes the result by the specified number of days. 

 

 Syntax: CURDATE() 

 The function is used with no parameters. 

 

 Examples: 

To show all posted GL transactions for today: 

"GLT_CURRENT__TRANSACTION"."Accounting_Date" = CURDATE() 

To show all JC Jobs that started in the last 7 days: 

"JCM_MASTER__JOB"."Actual_Start_Date" >= CURDATE() – 7 

Back to Top 

DAYOFMONTH() - Day of the month 

The DAYOFMONTH() function returns the day of the month (1 through 31) from the given 

date parameter. 
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 Syntax: DAYOFMONTH(<date>) 

 The function takes one parameter, a date field. This can be a database field or the 

CURDATE() function. 

 

 Examples: 

To show posted JC transactions that occurred on the first day of any month: 

DAYOFMONTH("JCT_CURRENT__TRANSACTION"."Accounting_Date") = 1 

This function could be combined with the MONTH() function to see if today is an employee’s 

employment anniversary date: 

MONTH("PRM_MASTER__EMPLOYEE"."Hire_Date") = MONTH(CURDATE()) AND 

DAYOFMONTH("PRM_MASTER__EMPLOYEE"."Hire_Date") = DAYOFMONTH(CURDATE()) 

Back to Top 

 

DAYOFWEEK() - Day of the week 

The DAYOFWEEK() function returns the day of the week (1 through 7, Sunday is the first day 

of the week) from the given date parameter. 

 

 Syntax: DAYOFWEEK(<date>) 

 The function takes one parameter, a date field. This can be a database field or the 

CURDATE() function. 

 

  Example: 

To show AP Invoices that have an Invoice date that falls on a Monday: 

DAYOFWEEK("APM_MASTER__INVOICE"."Invoice_Date") = 2 

Back to Top 

 

MONTH() - Month of the year 

The Month() function returns the month of the year (1 through 12) from the given date 

parameter. 

 

 Syntax: MONTH(<date>) 

 The function takes one parameter, a date field. This can be a database field or the 

CURDATE() function. 
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Examples: 

To show any AP checks that were written in the month of June: 

Month("APM_MASTER__CHECK"."Check_Date") = 6 

This function could be combined with the DAYOFMONTH() function to see if today is an 

employee’s employment anniversary date: 

MONTH("PRM_MASTER__EMPLOYEE"."Hire_Date") = MONTH(CURDATE()) AND 

DAYOFMONTH("PRM_MASTER__EMPLOYEE"."Hire_Date") = DAYOFMONTH(CURDATE()) 

Back to Top 

 

YEAR() - Year 

The YEAR() function returns the year from the given date parameter. 

 

 Syntax: YEAR(<date>) 

 The function takes one parameter, a date field. This can be a database field or the 

CURDATE() function. 

 

 Examples: 

To find CM Transactions entered in the current year: 

YEAR("CMT_REGISTER__TRANSACTION"."Accounting_Date") = YEAR(CURDATE()) 

To find CM Transactions from last year that should be moved to the history file: 

YEAR("CMT_REGISTER__TRANSACTION"."Accounting_Date") = YEAR(CURDATE()) – 1 

Back to Top 

 

LENGTH() - Length of text 

The LENGTH() function returns the number of characters in a string of text. 

 

 Syntax: LENGTH(<text>) 

 The function takes one parameter, a text field, and returns the number of characters in it 

(including spaces). 

 

 Example: 
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To show any JC Jobs with a description longer than 20 characters (which may not appear well 

on some reports): 

LENGTH("JCM_MASTER__JOB"."Description") > 20 

Back to Top 

 

CONCAT() - Concatenate 

The CONCAT() function puts two text fields together. 

 

 Syntax: CONCAT(<text1>,<text2>) 

 The function takes two parameters, both are text fields, and returns them joined together. 

 

 Example: 

For a JC Job record where Job='03-001' and Description='NW Food Warehouse', then using 

the function like this: 

CONCAT("JCM_MASTER__JOB"."Job", "JCM_MASTER__JOB"."Description") 

would return the value: 03-001NW Food Warehouse. 

Back to Top 

 

LTRIM() - Trim space characters from the left side of a text field 

The LTRIM() function removes preceding spaces from the beginning of a text field. 

 

 Syntax: LTRIM(<text>) 

 The function takes one parameter, a text field, and returns the text field with spaces at the 

beginning removed. 

 

 Example: 

This formula could be used to return records where a name was accidentally entered with a 

space in front of it (which would prevent that field from sorting correctly): 

LTRIM("APM_MASTER__VENDOR"."Name") <> "APM_MASTER__VENDOR"."Name" 

Back to Top 
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RTRIM() - Trim space characters from the right side of a text field 

The RTRIM() function removes succeeding spaces from the end of a text field. 

 

 Syntax: RTRIM(<text>) 

 The function takes one parameter, a text field, and returns the text field with spaces at the 

end removed. 

 

 Example: 

This formula could be used to return records where a name was accidentally entered with a 

space at the end of it: 

RTRIM("APM_MASTER__VENDOR"."Name") <> "APM_MASTER__VENDOR"."Name" 

Back to Top 

 

SUBSTRING() - Return a portion of a text field 

The SUBSTRING() function returns a specified amount of text from a specified position of the 

given text field. 

 

 Syntax: SUBSTRING(<text>, starting position [, length]) 

 The function can take 2 or 3 parameters. 

The first parameter is the text field to be searched 

The second parameter is the starting position of the substring (The first character of the text 

field is position 1) 

The third parameter is optional. It is the number of characters to get from the starting 

position. If this parameter is left out, the function will return text starting from the starting 

position all the way to the end of the text field.  

Examples: 

If you know the prefix length of an account in GL is 9 characters (including dashes), and there 

was no suffix, you can use this function to get just the base account. If you wanted to show 

all posted transactions to base account 5120 (and the account format was xxx- xxxx-xxxx): 

SUBSTRING("GLT_CURRENT__TRANSACTION"."Account",10) = '5120' 

In the same situation as above, but the account format contained a suffix that you wanted to 

ignore (xxx-xxxx-xxxx.xx): 

SUBSTRING("GLT_CURRENT__TRANSACTION"."Account",10,4) = '5120' 
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LOCATE() - Find a substring in a text field 

The LOCATE() function performs a case-sensitive search of a text field for a given string of 

text, and returns the position of the text being searched. If the text you are looking for is not 

found, then this function returns 0. 

 

 Syntax: LOCATE(<text to find>, <field to search> [, starting position]) 

 The function can take 2 or 3 parameters. 

The first parameter is the text you want to find. 

The second parameter is the text field you want to search. 

The third parameter is optional. It is the position where you want to start looking (the first 

character is at position 1). If this field is left out, then it will start looking at the beginning of 

the text field. 

 Examples: 

If you want to show all AP Vendors that have "LLC" anywhere in their name: 

LOCATE('LLC', "APM_MASTER__VENDOR"."Name") 

If you want to show all PM Properties that have the word "Garage" anywhere in the property 

name, except for properties that begin with the word "Garage": 

LOCATE('Garage', "PMP_PROPERTY__PROPERTY"."Name", 2) 

Back to Top 

 

LEFT() - Display a given number of characters from the left of a text field 

The LEFT() function returns a specified number of characters from the left side of a text field. 

 

 Syntax: LEFT(<text>, length) 

 The function takes 2 parameters. The first parameter is the text field to use. The second 

parameter is the number of characters to return from the left side of the string. 

 

 Example: 

If the JC Cost Code field is formatted xxx- xxxx, where the first 4 characters are the Group 

Cost Code, and you wanted to use that to show all cost codes in the 400 group: 

LEFT("JCM_MASTER__COST_CODE"."Cost_Code",3) = '400' 

Back to Top 
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RIGHT() - Display a given number of characters from the right of a text field 

The RIGHT() function returns a specified number of characters from the left side of a text 

field. 

 

 Syntax: RIGHT(<text>, length) 

 The function takes 2 parameters. The first parameter is the text field to use. The second 

parameter is the number of characters to return from the RIGHT side of the string. 

 

 Example: 

If the JC Job field is formatted xxxx-xxxx, where the last 4 characters represent the year the 

job started, and you wanted to use that to show all jobs that started in 2005: 

RIGHT("JCM_MASTER__JOB"."Job", 4) = '2005' 

Back to Top 

 

CONVERT() - Convert a given field to another data type 

The CONVERT() function changes the type of a field to a specified type. 

 

 Syntax: CONVERT(<field>, <type>) 

 The function takes two parameters. The first parameter is the field to be converted. The 

second parameter is the data type to convert to. The following is a list of those types: 

SQL_BIT (1 = TRUE, 0 = FALSE) 

SQL_DATE (year, month, day) 

SQL_DECIMAL 

SQL_DOUBLE 

SQL_REAL 

SQL_INTEGER (use this if you want to drop the decimal part of a number, not to round). 

SQL_VARCHAR (use this to convert to text) 
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Examples: 

If the JC Job field was formatted as xx-xxxx, where the last four characters represented the 

year in which the job started, using the RIGHT() function to get the year would return the 

year as text. If you wanted to compare that value to the current year using YEAR(CURDATE()), 

the year would be returned as an integer. You can convert the number to text and then 

compare: 

RIGHT("JCM_MASTER__JOB"."Job", 4) = CONVERT(YEAR(CURDATE()),SQL_VARCHAR) 

To create a date from text: 

CONVERT('2006-01-31', SQL_DATE) 

Back to Top 

 

IS NULL/IS NOT NULL - Determine if a field is (or is not) blank 

These expressions is used to determine if a field is or is not null (empty). Dates can be empty, 

as can many text or numeric fields before they are given a value. A field is Null is different 

from it containing a 0 or blank. 

 

 Syntax: <field> IS NULL –or– <field> IS NOT NULL 

 Use this expression to determine if the field is empty. 

 

 Examples: 

To show all PR Employees who have not been terminated: 

"PRM_MASTER__EMPLOYEE"."Terminate_Date" IS NULL 

To show all AP Invoices that have a Discount Date entered: 

"APM_MASTER__INVOICE"."Discount_Date" IS NOT NULL 

To see CM Transactions where the payee field is blank: 

"CMT_REGISTER__TRANSACTION"." Payee" IS NULL OR 

"CMT_REGISTER__TRANSACTION"."Payee" = '' 

Back to Top 
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NOT() - Switch boolean value of a field 

The NOT() function will reverse the value of the expression within the parentheses. If the 

expression results to TRUE, then the resulting value after the NOT operation will be FALSE. If 

the expression results to FALSE, then the resulting value after the NOT operation will be 

TRUE. 

 

 Syntax: NOT(<logical expression>) 

 Reverses the value of the expression. 

 

 Examples: 

To show all AP vendors who are not 1099 recipients: 

NOT("APM_MASTER__VENDOR"."Receives_Form_1099" = 1) 

To show all GL Accounts that are not Suspense or Units accounts: 

NOT("GLM_MASTER__ACCOUNT"."Account_Type" IN ('Suspense','Units')) 

Back to Top 

 

UCASE() - Convert text to UPPER CASE 

The UCASE() function makes the specified text field all upper case. 

 

 Syntax: UCASE(<text field>) 

 Converts the specified text field to upper case. 

 

 Examples: 

To show all AP Vendor IDs that are not in all upper case letters: 

UCASE("APM_MASTER__VENDOR"." Vendor") <> " APM_MASTER__VENDOR"."Vendor" 

Back to Top 

 

LCASE() - Convert text to lower case 

The LCASE() function makes the specified text field all lower case. 

 

 Syntax: LCASE(<text field>) 

 Converts the specified text field to lower case. 

Examples: 
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To show all Invoices with the word "window" in the description: 

LOCATE('window', LCASE("APM_MASTER__INVOICE"."Description") 

Back to Top 
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Data Folders 
 

 

When configuring the MyAssistant Server, you can choose to have MyAssistant monitor and 

report on multiple Sage data folders. If MyAssistant is set up this way, you'll choose in Task 

Setup which data folder(s) you want to run a Task for. to choose which data folders it will run 

for. 

 

Tasks can be run on more than one data folder, and you can change which data folder(s) a 

Task runs on after it has been initially set up. 

 

If MyAssistant is only monitoring one Sage data folder, this step will be skipped in Task 

Setup. 

 

Tip: Use the preview in the Condition step to confirm that each Sage data folder 

you want to run a Task for has the information you want to monitor 
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Task Schedule 
 

 

Many customers like the ability to send or receive information automatically. With 

MyAssistant, Tasks can be set up to run and send emails automatically on a Schedule. Every 

Task has its own Schedule, which controls the days & times a Task runs. Since Tasks run & 

emails send from the server, many companies schedule Tasks to run outside business hours 

and on weekends. 

Examples include: 

▪ On the first day of every month at 5am 

▪ Every other Wednesday at 3pm 

▪ The last Friday of every month 

▪ Every weekday at 8am  

Tip: Tasks that are set to run on a schedule can still be run manually. For example: A Task 

scheduled to send an email every Friday is manually run on Tuesday. The Task will run and 

send an email (if it finds information to send) on Tuesday, then still runs automatically on 

Friday. 

 

How to add a Schedule to a Task 

1. Get to the Schedule step of Task Setup.  

Note: Schedules can be added while setting up a Task or after it is activated 

2. Click the circle next to "On a schedule" 

3. Choose when you'd like the Task to run (Daily, Weekly, Monthly, etc.) 

4. Choose time & day customizations (which will change depending on what you pick) 

5. To add another schedule, click "Add another schedule" and repeat steps 3 & 4 

6. Click "Next" to go the Email step of Task Setup or "OK" to close the window 

(depending on when you're adding the Schedule to the Task).  

 

Daily Schedule Customizations 

A "Daily" schedule lets you choose:  

▪ What time the Task runs 

▪ What days the Task will run (e.g. every day, every other day, every 3 days, etc.) 
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Weekly Schedule Customizations 

A "Weekly" schedule lets you choose: 

▪ What time the Task runs 

▪ What days of the week a Task will run 

▪ What weeks the Task will run (e.g. every week, every other week, etc.) 

 

 

Monthly Schedule Customizations 

A "Monthly" schedule lets you choose: 

▪ What time the Task runs 

▪ What day of the month the Task runs: 

▪ A specific date (e.g. the 15th), or 

▪ A specific day (e.g. the last Monday of the month) 

▪ Which months the Task will run 
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Email 
 

 

The Email step of Task Setup is where you specify who MyAssistant should email when 

information is found. It is also where you control what's in the emails that are sent, including 

any attachments. 

 

Recipients 
The Task can send emails to the recipients specified in the To, Cc and Bcc lines; or 

MyAssistant can look up who to notify based on the information found by the Task. For more 

information on recipients, click here 

 

Email content 
Emails sent by MyAssistant Tasks most often contain a combination of one or more of the 

following: 

 

List of alerts or other items in message body 

A table in the body of an email containing one row per item being monitored by the Task 

Condition (e.g. JC Job). In the Email step, you'll select the columns that appear in the email(s) 

that are sent, as well as any messaging above or below the table
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Attached Spreadsheet 

The latest information from Sage in an easy-to-read attached Excel spreadsheet. MyAssistant 

attaches what's called a "spreadsheet template" to the Task to create the spreadsheet -- this 

is what determines the Sage information that will be included in the spreadsheet and its 

layout. A template is used so no matter how much or how little information is found, the 

appearance of the spreadsheet's content is consistent.

 
 

 

Attached Reports 

Almost any report from a Sage reports menu can be emailed as an attached PDF from 

MyAssistant. Report designs created with Crystal Reports can also be used to send PDFs, 

Excel spreadsheets or text files as attachments. Documents or attached reports can also be 

attached and set up so each recipient would receive only their information. 
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Send a List of Notifications 
 

 

Sending a list of Notifications is one of the most popular uses of MyAssistant because of 

how easy it is to set up. Once you've chosen What to Send and selected your Condition, 

you'll pick what information will be included in the list. Examples include or AP Vendors with 

expiring insurance, Cost Codes over-budget by a specified amount, and Employees with 

birthdays in the next 14 days. 

 

Key Parts 
There are three key parts for sending a list: 

 

List Builder Section: The section at the bottom of the Email step where you will pick the 

columns that are included in your emailed list. You can also determine the columns' size and 

order, if the information should be grouped, and if there are any totals. 
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List of available Sage information: Also called the "Sage Field List", this section in the 

bottom-right of the Email step contains all the information that can be accessed based on 

what you're sending a list of in the email. What you're sending a list will always be the top 

group, followed by the other information you can access. Expand one of the groupings in the 

list and drag a field into the List Builder section to add it to your list: 

 

 
 

 

"Include above list in email" checkbox: This controls whether or not the list created in the 

"List Builder Section" will be included in the email(s) sent by the Task.  

 

 
 

Checking this box (if not already checked) will cause the gray text "The list defined below will 

be inserted here" to appear in the message section. This gray text indicates the position of 

the table in any emails sent by the Task. Any text or fields added above the gray text will 

appear above the emailed list, while any text under the line will appear below it. 
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How to Add Columns 
Expand any of the groups inside the "Sage Field List" in the bottom-right, then click and drag 

the field you want into the List Builder Section. 

 

 
 

 

Tip: Use the search bar at the top of the list to more quickly find the information you want to 

add. 

 

 

 

How to Rearrange Columns 
To change the order the columns appear in the list you send, click & drag a column header 

in the List Builder section and move it to the left or right. Blue triangles will show where the 

column will go when you release the click. 
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How To Remove Columns 

Many prebuilt Tasks already have columns added to the List Builder section. MyAssistant may 

also import some fields used in the Condition when creating your own Task. To remove any 

unwanted columns, click the X under the column header. 

 
 

 

How to Group by a Column 

The list in an email can be grouped by the information in a Sage field. For example, you can 

group JC Cost Codes by Job, AP Invoices by Vendor, or AR Invoices by Customer. To group 

information in a list by a Sage field, click and drag the Sage field from the list to the section 

labeled "Drag a column header here to group by that column": 

 

 
 

Related Links 

What to Send - Send a List of Notifications 

Send a List of Notifications Overview 

 

  



_______________________________________________________________________________________________________________________________________ 

Copyright © 2022 Innovative Software Design 72 

Send Reports & Documents 
 

 

MyAssistant can automatically generate and send reports and documents to recipients. This 

is done by first attaching a "report design" to a Task. 

 

How to attach a report 
There are two ways to attach a report design to a MyAssistant Task -- attach a "Sage Report", 

or attach a "Crystal Report" 

 
 

Sage Report: Almost any report on a Reports menu in Sage 300 can be attached to a 

MyAssistant Task. Please note: if a report was created in Sage Report Designer, it must be 

attached to a Sage Reports menu before attaching it to a MyAssistant Task. 

 

To attach a Sage report to a Task, click the "Sage Report" button in the ribbon. This will open 

a window showing all Sage reports that you can access, grouped by application: 

 
Expand the folders, select the report you want to attach and click "OK" 

 

Tip: Use the search bar at the top of the list to more quickly find the report you want 
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Crystal Report: Report designs created with the Crystal Reports software can be attached 

directly to a MyAssistant Task by clicking the "Crystal Reports" button and navigating to 

where the report design is on your computer.  

 
 

Report Options 
After attaching a Sage report or a Crystal Reports design to a Task, a window will open that 

will feature several options around the report. 
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Attachment Name: This is the name of the attachment on the email(s) sent by the Task. You 

can also use information from Sage in the attachment name by clicking the "Use Sage value 

in name..." button. For example: If you were sending each Customer their monthly statement, 

you could add the "Name" field from the AR Customer Setup to the attachment name.  

 

Attachment Type: Crystal Report designs can produce a PDF, an Excel spreadsheet, a plain 

text document, or Comma Separated Values (CSV) file attached to emails. Reports attached 

from Sage are always sent as PDFs 

 

Protect PDF with Password: You can password-protect PDFs sent with MyAssistant, and 

you use a Sage field to have a unique password for each recipient. For example, you can 

password-protected each employee's pay stub with the last four digits of their SSN. 

 

Report Prompts: Any prompts the report needs in order to fill out its contents will be 

displayed in a specific section. These prompts can be filled in with a set value that will be the 

same time you'll see a list of those parameters below. Each parameter can be loaded with a 

specified value, a Sage 300 CRE Data field, or a MyAssistant Formula.  

 

Note: Reports are run on a per-email basis. This means that if the Task email is set up to use an Email 

Directory, then the report will run once for each Email Directory Recipient's email. 

  

Save Report Attachment: MyAssistant can save a copy of each attached report, document 

or spreadsheet sent by the Task to a location on a computer. Click here for more information   

 

Related Links 

Send Reports & Documents Overview 
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Send a Spreadsheet 

 

 

Many people like to receive information in an Excel spreadsheet. Any information in Sage can 

be sent in a spreadsheet using MyAssistant. Examples include AR Aging Spreadsheets, Job 

Cost Breakdown spreadsheets, and AP cash flow spreadsheets. Spreadsheets can be added 

to MyAssistant Tasks using Spreadsheet Templates, which define the spreadsheet's content 

and layout. 

 

Key Parts 

There are three key parts to sending a spreadsheet 

 

List Builder Section: Normally used when sending a list of items in the body of an email. 

However, this section in the bottom-middle of the Email step is where you will pick the 

columns to be included in your emailed spreadsheet. You can also determine the columns' 

order, if the information should be grouped, and if there are any totals. 
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List of available Sage information: Also called the "Sage Field List", this section in the 

bottom-right of the Email step contains all the information that can be accessed based on 

what you're sending in your spreadsheet. What you're sending one row per will always be 

the top group, followed by the other information you can access. Expand one of the 

groupings in the list and drag a field into the List Builder section to add it: 

 

 

 

Spreadsheet Template: Sets the format for how information should appear in the 

spreadsheet. Spreadsheet templates are added to a Task by clicking the Spreadsheet 

Template button in the Email Step of Task Setup and selecting either "New" or Use 

Notification List 
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How to Attach a Spreadsheet to an Email 

Any MyAssistant Task can send a spreadsheet if one isn't already attached. The most efficient 

way to send an attached spreadsheet is to take a Task that would normally send a list in the 

body of an email and turn it into a Spreadsheet Template. 

1. Select or create a Condition that will create a mailing list (i.e. only find information for 

the people you want to email) 

2. Add the fields you want in your spreadsheet to the List Builder section in the Email 

step of Task Setup 

 

 

3. Create a Spreadsheet Template by clicking "Spreadsheet Template" and selecting 

"Use Notification List"

 

 

4. Click and drag the edges of the columns in the spreadsheet to resize them as desired 
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5. Make any other changes to the spreadsheet template (e.g. bolding and centering 

column headings) 

Click "Save & Close" to save the spreadsheet template 

 

6. Accept the default spreadsheet template name or enter a new one 

 
 

Tip: Any MyAssistant Task that sends a list of items in an email can be updated to send a spreadsheet 

using the above steps. 

 

Related Links 

Send a Spreadsheet Overview 
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Send Each Person Their Information 
 

 

A popular use of MyAssistant is to send multiple recipients only their information with a 

single Task. Common examples include: 

▪ Weekly direct deposit pay stubs to Employees  

▪ Electronic payment notices to Vendors 

▪ Service Management invoices to Customers 

▪ Reports and spreadsheets to Project Managers containing only their jobs 

 

Keys to Sending Each Person their Information 

 
Mailing List with the Task Condition: When sending each recipient only their information, 

the Task Condition determines who should be sent an email and who shouldn't. For example: 

 Task Goal Task Condition  Mailing List That's Created 

Send employees their 

weekly pay stubs 

PR Checks from the most 

recent pay period 

Employees who got a check 

in the last pay period 

Send ACH payment notices 

to Vendors 

AP Electronic Payments in the 

last 3 days 

Vendors who were paid 

electronically in the last 3 

days 

Send Project Managers 

reports for their over-

budget Jobs 

In progress Jobs that are 

over-budget and have a 

Project Manager specified 

Only the Project Managers 

who have over-budget Jobs 

 

Email Directory to look up recipients: MyAssistant Email Directories look up email 

addresses in Sage for each item found by the Task Condition. Once MyAssistant has 

associated an email address with each item found by the Condition, it separates them into a 

separate email for each recipient. 

 

To add an Email Directory to a MyAssistant Task, click the "Email Directory" button in the 

Email Step of Task Setup. Select the Email Directory you want to use, then click the button 

that matches where you want to add it (e.g. the "To" line, "Cc" line, etc.): 
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TIP: MyAssistant automatically filters what Email Directories are available on a Task, 

depending on where the Task is looking for email addresses and what information is being 

looked up by the Task. MyAssistant will only show Email Directories where a direct 

relationship exists. 

 

Related: Email Directories 

 

 

Prompts on Reports that filter the attachment's contents: When using MyAssistant to 

send attached PDFs like pay stubs, Customer statements, Job reports and more; you'll use 

prompts on the attached reports to filter the content for each email message. When you 

attach the report, change each applicable prompt so it will use the value from a Sage field -- 

this is how the report will create different content for different recipients: 

 

 For example: To send each employee their pay stub, attach a report design that prompts for 

Employee ID and Period End Date. When the Report Options window opens, change the 

prompts to use Sage fields: 

 

 
 

Now the report will use the Employee ID and Period End Date from the check associated with 

each email to fill out the report’s prompts. 

 

IMPORTANT: Attached reports run once per email message created by the Task. If a report is 

using information from Sage to fill out report prompts and there is more than one value that 

can be used for a prompt (e.g. multiple Employee checks in one email), the attached report 

will use one random value to use in the report prompt. 
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Please note: this third key is not used when sending lists of alerts in the message body or 

spreadsheets 

 

When Set Up Correctly: 

1. The MyAssistant Task creates a mailing list based on the Condition's criteria 

2. The Email Directory on the Task associates an email address with each item found by 

the Condition 

3. Items are grouped and sorted into a separate email per recipient email address 

4. Email content is created for each recipient, including any attached reports being run 

once per email. The attached report's prompts are set up to filter its content for each 

recipient 

5. MyAssistant emails each recipient a separate message with only their information 

 

 

To send each recipient only their items in a list 
1. Select or create a Condition that will create a mailing list (i.e. only find information for 

the people you want to email) 

2. Create the list of alerts you want to send in the Email step of Task Setup 

3. Add an Email Directory to the Task 

When set up correctly: MyAssistant will send an email to each recipient with a list of only 

their items in the message. 

 

To send each recipient a spreadsheet of only their information 
1. Select or create a Condition that will create a mailing list (i.e. only find information for 

the people you want to email) 

2. Add the fields you want in your spreadsheet to the List Builder section in the Email 

step of Task Setup 

3. Create a Spreadsheet Template by clicking "Spreadsheet Template" and selecting 

"Use Notification List" 

 
 

4. Adjust and save the Spreadsheet Template. More information on Spreadsheets can 

be found here. 

 

  



_______________________________________________________________________________________________________________________________________ 

Copyright © 2022 Innovative Software Design 82 

5. Add an Email Directory to the Task 

 
When set up correctly: The Task will send each recipient an email with an attached 

spreadsheet containing only their information. 

 

 

To send each recipient only their documents/reports 
1. Select or create a Condition that will create a mailing list (i.e. only find information for 

the people you want to email) 
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2. Attach an Email Directory to the Task in the Email step of Task Setup 

 

 

3. Attach a report design to the MyAssistant Task, and use Sage fields to fill out the 

report prompts in the middle of the Report Options window
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Recipients 
 

 

A key part of MyAssistant Tasks is determining who should be sent emails. MyAssistant can 

send emails to a set list of recipients, or it can look up who to notify based on the 

information found. 

 

Set Recipient List 
To have a MyAssistant Task send emails to the same recipients every time, enter e-mail 

addresses in the TO or CC fields, or click on the TO or CC buttons and select one or more 

names from your Outlook address book. The person's name and e-mail address will be 

entered in the corresponding recipient fields.  

 

Tip: To type more than one email address on a line, add a semicolon (;) and a space 

between each email address 

 

 

BCC 

Some companies want to add someone as a recipient but don't want other recipients to 

worry. To add a recipient as a Bcc, click the View tab and click the "Bcc/Also" button. 

Recipients listed on this field will receive emails, but will not be seen by other recipients.  

 
 

 

Tip: If you do not want a Task to send any emails, leave all recipient fields blank  
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Email Directories 
An Email Directory tells MyAssistant what email address to use to send each recipient only 

their information. 

 

To add an Email Directory in a Task: 

1. Get to the Email step of Task Setup 

2. Under the Home tab, click the Email Directories button at the top 

3. Select the Directory you wish to notify and choose TO, CC, or BCC 

4. Click OK 

 
 

For more information on Email Directories, click here 
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Saving Copies of Emailed Attachments 
 

 

Many companies like to keep copies of the reports, documents and spreadsheets they send 

with MyAssistant. Some will just Cc or Bcc someone in the company, then set up a rule in the 

recipient’s Outlook to automatically move the messages. Other companies will use 

MyAssistant to save copies of emailed attachments to a location on their server. 

 

With MyAssistant, you can save a copy of any attached report, document or spreadsheet to a 

location on a server. 

 

When using a MyAssistant Task that uses an Email Directory and attached report prompts to 

send each recipient reports with just their information, you can save each report in a unique 

location. This enables companies to be more organized  

 

Key Pieces 

 
Save Location: Also known as the "Save File Path", this is where you choose to save copies 

of the attachments sent by the Tasks. Since Tasks run and emails send from your server, most 

companies will choose to save copies of attachments to a location on the same machine. 

Where an attachment is saved is determined in the Report Options window after attaching a 

report to a Task: 
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NOTE: If you want to save copies of attachments to a server other than the one with the 

MyAssistant Server software installed, there are a couple things to consider: 

5. The location needs to be accessible from the MyAssistant Server using what's called 

a UNC path 

6. MyAssistant sends generates and sends emails and attached reports using a process 

on your server called a Windows service (named "ISDAdminSenderService"). Every 

Windows service have to run as a Windows user, and the ISDAdminSenderService 

may need to be updated to run as a Windows user with sufficient permissions to the 

other computer. 

 

Folders Created based on Sage information: To help you stay organized and keep track of 

reports you've saved, MyAssistant can create folders based on the information in Sage fields. 

For example, if you're saving a copy of each Job Cost report sent for each Job, MyAssistant 

can create folders named after the Job number or Description. 

 

Attachment Name:  This is what the name of the attachment will be once it's saved to a 

location on disk 

 

Tip: Add a Sage field or MyAssistant formula (e.g. "Current Date" formula) to make the 

name of each attachment copy saved by the Task unique. If MyAssistant tries to save a copy 

of an attachment and finds another in the same location with the same name, it will 

overwrite the existing attachment with the new one 

 

How to save reports and documents attached with the "Sage Report" or 

"Crystal Report" options: 

 
MyAssistant can automatically create folders based on the values of Sage fields added to the 

save path. In your example, you can have MyAssistant use a unique folder for each Property. 

Here are the steps: 

1. Select your activated MyAssistant Task & click “Open” 

2. Click “Email” on the left side of the window that opens 

3. Double-click on your report design in the “Attachments” section under the Subject 

line 

4. Check the box for “Save file attachment” (or confirm it’s already checked) at the 

bottom of the window that opens 

5. Select or confirm the current path where reports are currently being saved 

6. Place your cursor at the end of the file path and press the “\” key on your keyboard 

7. Click [Use Sage value in folder name…]  

8. Choose the Sage field or MyAssistant formula you want to use to create folders and 

click “Insert”. The save file path should now look something like this: 

 
9. Repeat steps 7 & 8 if you’d like to use multiple Sage fields in the save file path  

10. Click "OK" to close the Report Options window 

11. Click "OK" to close Task Setup 
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How to Save Spreadsheets Created with MyAssistant Spreadsheet 

Templates: 
MyAssistant can automatically create folders based on the values of Sage fields added to the 

save path. In your example, you can have MyAssistant use a unique folder for each Property. 

Here are the steps: 

1. Select your activated MyAssistant Task & click “Open” 

2. Click “Email” on the left side of the window that opens 

3. Double-click on the spreadsheet template in the Attachments section under the 

Subject Line 

4. Click the "Page Layout" tab of the ribbon and click "Rename Workbook" 

5. In the window that opens, select the path where you want to save copies of the 

spreadsheet(s) sent by the Task 

 
 

Related Links 

Send a Spreadsheet Overview 

Send a Spreadsheet 
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"From" Email Address 
 

 

Companies often want to use MyAssistant to automate or work with multiple aspects of their 

business. As such, a common request is having MyAssistant send emails from different email 

addresses. With MyAssistant, you can send messages from different Email Addresses. 

 

Keys for Multiple "From" Email Addresses 

Setting up MyAssistant to use multiple emails: Part of the initial setup of MyAssistant is to 

determine what email address(es) MyAssistant will use to send emails. If MyAssistant was not 

initially set up to use multiple "From" email addresses, this can be updated in the Server 

Settings step in the MyAssistant Designer's options. 

 

Selecting a "From" Email Address in Task Setup: Once MyAssistant has been set up to use 

multiple "From" email addresses, select which one to use in the Email step of Task Setup. 

NOTE: If no "From" email address is specified in the Email Step of Task Setup, MyAssistant 

will use whichever email address is specified as the "Default". Changing which "From" email 

address is the default can also be done in the Server Settings step in the MyAssistant 

Designer's Options. 

 

To Change the "From" email on a Task 

1. Get to the Email step of the MyAssistant Task. You'll go through this step when 

initially setting up a Task, or by clicking on "Email" on the left side of the window 

when opening an already-activated Task. 

2. Click the "View" tab of the button bar at the top of the window 

3. Click the From button to add the "From" line above the "To" line 
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4. Click the "From" button that's appeared and select the email that this Task should use 

 
 

5. Finish Task Setup or click "OK" in the bottom-right to save your changes 
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Task Options 
 

 

This step is used to set or confirm several options when setting up a MyAssistant Task. 

 

Notification Frequency 
The Sage information found by a Task are called "Notifications"; and this step controls how 

many emails recipients are sent about each Notification. The two options are: 

 

Each Time the Task Runs: Recipients receive all Notifications found by the Task every time it 

runs.  

For example: a Task looking at all JC Jobs finds 50 jobs, then emails you a list of all 50 Jobs. 

The Task is run again a week later and finds 52 Jobs -- you are then sent a list of 52 Jobs. 

 

Once: Recipients are emailed each Notification once. Also referred to as "Notify Once", this is 

often used when only wanting to be sent new information in Sage. 

 

For example: The first time a Task looking at all JC Jobs is ran, it finds and sends you a list of 

50 Jobs. The following week, the Task runs again and finds 52 Jobs. This time, you are only 

sent the two new Jobs, because you were previously notified of the other 50. 

 

 

Reminder: Regardless of the option selected, all Notifications found by the Task will appear 

in the MyAssistant software after the Task is run. 

 

Separate Email for Each / "Send Once Per" 
This lets you send information normally in one email in separate messages. When this 

feature is used, MyAssistant will send recipients a separate email for each unique value in the 

Sage field or MyAssistant formula you select. 

 

To use, click the dropdown and select the Sage field or formula you want to use to create 

separate emails. 

 

To clear the selection, click the eraser icon to the right of the dropdown. 

 

Tip: When using the "Send Once Per" feature, any attached reports being used to send each 

recipient only their information should have a prompt for the same Sage field or 

MyAssistant formula selected. 

 

 

Send in Daily Summary 
Tasks that send a list in an email and have no attachments can be compiled into a once-a-

day "Daily Summary" email sent to recipients. 
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Keep Closed Notifications 
This controls whether or not MyAssistant keeps a record of the Notifications that met the 

Task's criteria on a previous run, but not the most recent run.  

 

Important: This box must be checked if you're using run the "Notify Once" feature (set in 

Notification Frequency) 

 

 

Don't Display in Live Tile 
Some companies want multiple people to be able to run MyAssistant Tasks, but not create or 

modify them. For employees who only can run MyAssistant Tasks and send emails, 

companies can purchase licenses for the "MyAssistant Live Tile". This checkbox controls 

whether or not a Task that a company has set up can be seen or run by employees with the 

MyAssistant Live Tile.  

 

Task Name 
The name of the Task as it will appear in MyAssistant. New Task names will prefill with the 

Subject line entered in the Email step, but can be changed. 

 

Category 
MyAssistant Tasks can be placed in Categories to keep similar Tasks together and help you 

stay organized. Tasks can be placed in the existing Categories that come with MyAssistant, or 

you can create your own. 

 

Subcategory 
Subcategories are used within in Categories to keep similar Tasks together to an even 

greater level of organization (e.g. keeping all Tasks that have to do with HR within the "HR" 

subcategory inside the "Payroll" category. You can use existing Subcategories create your 

own in existing Categories or in Categories you create.  

 

Description 
An optional field that allows you to write a brief summary of what a Task looks for/sends and 

the intended recipients. 
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Email Directories 
 

 

An Email Directory tells MyAssistant what email address to use to send each recipient only 

their information. This means that MyAssistant can do things like send each Project Manager 

the over-budget Cost Codes on only their jobs, send each tenant only their monthly rent 

statement, send each employee their weekly pay statement, or send each customer 

information about only their past-due invoices. 

 

How to create an Email Directory 

There are two ways to set up an Email Directory. You can enter email addresses in a field in 

Sage 300 CRE, or you can enter email addresses in the MyAssistant Email Directory setup. 

  

Option 1: Look up Email Addresses in Sage  

If you're entering email addresses in a specific location in Sage, MyAssistant can look at that 

location for its Email Directory. 

1. Start the MyAssistant Designer 

2. Select File > Email Directories  

 

3. Click "New" in the window that opens 

4. Enter a name for the Email Directory in the window that opens. Each Email Directory 

must have a unique name. 

5. Select "Lookup Email addresses in Sage 300 CRE" and click "Next" 
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6. Select the Sage 300 CRE data record where the email address will be entered  

7. Select the field on the selected Sage 300 CRE record where email addresses will be 

entered 

 

8. Click View <Record Name> records missing an Email address if you would like to test 

the selected field for blanks 

9. Click Finish 

 

Option 2: Enter email addresses in MyAssistant 

1. Start MyAssistant Designer  

2. Select File > Email Directories 

 

3. Click New  

4. Enter a name for the Email Directory in the window that opens. Each Email Directory 

must have a unique name. 

5. Select "Lookup Email addresses in a list that you provide" and click "Next" 
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6. Select the Sage 300 CRE data record that will be used to look up email addresses 

7. Select the Sage 300 CRE data field that will be used to look up email addresses 

8. Click "Prefill <Field Name> fields Sage 300 CRE" 

9. Select your data folder if needed then click OK 

 

 

10. For each value, type an email address or select the email address from your Outlook 

by clicking the "..." button 

11. Click View <Record Name> records missing values if you would like to test the 

selected field for blanks 

12. Click Finish 

 

Note: MyAssistant automatically filters what Email Directories are available on a Task 

based on the data relationship between where the Email Directory looks up information 

and what information the Task is monitoring. If a Task is monitoring information that 

doesn't have a direct relationship to the location where an Email Directory is looking for 

email addresses, the Email Directory can't be added to the Task. 

 

Related Links 

Send Reports & Documents Overview 

Send Each Person Their Information 
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Error Log 

 

 

If an error occurs or if you're not sure if something is working correctly, the MyAssistant 

Designer has a System Log that identifies and explains (in non-technical terms) what, if 

anything, happened. You can view the System Log by opening the MyAssistant Designer, 

clicking File, and selecting "System Log". 

 

 
 

 

When the log opens, events will be sorted with the most recent at the top. In most cases you 

can solve the common issues yourself with the step-by-step instructions provided. If 

someone else needs to review the log, you can export a copy by clicking the "Export Log" 

button in the ribbon.  
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Settings 
 

 

MyAssistant has two parts: the MyAssistant Server software and the MyAssistant 

workstation(s). After installing and configuring the MyAssistant Server software, the next 

thing that will be installed will be MyAssistant on any workstations where it will be used. 

 

After a MyAssistant workstation has been installed, it will need to be configured -- this 

section covers the steps involved in configuring a MyAssistant workstation, as well as the 

information that can be updated afterwards from within a MyAssistant Designer. 

 

Configuring a MyAssistant workstation involves the following steps: 

1. Activate the MyAssistant workstation license (either MyAssistant Designer or 

MyAssistant) 

2. Enter the Sage user name and password MyAssistant will use for local processes (e.g. 

browsing data) 

3. Enter information about yourself  

 

Reviewing the above items and more after configuring a MyAssistant Designer can be done 

by opening the MyAssistant Designer, clicking "File" and selecting "Options": 
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Activating MyAssistant 
 

 

MyAssistant workstations must be activated to use the software. Each MyAssistant 

workstation is tied to a Windows user on a computer. Make sure that you are logged in as 

the Windows User who will use MyAssistant prior to activation. This may not the same as the 

Windows account used to install the MyAssistant workstation. 

 

 
 

MyAssistant product keys are available in the Sage Customer Portal where you get your Sage 

product keys.  

 

Enter the following information in their respective fields: 

 

▪ Customer Number: Sage customer number assigned to your company. This can be 

found in the Sage Customer Portal, or by opening a Sage 300 application and clicking 

Help > About [Application Name] 

▪ Product Key: MyAssistant Workstation product key. This will be one of two licenses:  

MyAssistant Designer – The full version of MyAssistant. The MyAssistant 

Designer provides the ability to create, activate and change Tasks; as well as 

run Tasks and view what was found. 

 

MyAssistant – MyAssistant has the ability to run MyAssistant Tasks on 

demand and view what was found.  
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Sage 300 Data Folders 
 

 

This step controls what Sage user MyAssistant will use locally, and confirm the data folder(s) 

MyAssistant will monitor:  

 

 
 

Specify Sage 300 CRE data folder locations 

The data folders specified during the MyAssistant Server Configuration will be listed in the 

grid. Click in the grid to select any data folder paths that do not prefill.  

 

Check the "Ignore" checkbox for any Sage 300 CRE data folders that should not be accessed 

on this workstation.  

 

Sage 300 CRE User and Password  

Enter the Sage User & password for the person using MyAssistant. This will be used to: 

▪ Access Sage 300 CRE reports that can be attached to Tasks 

▪ Test Task Conditions 

▪ Test MyAssistant Formulas 

▪ Preview MyAssistant Spreadsheet Templates 
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Server Settings 
 

 

This controls a variety of MyAssistant Server settings that can be updated from the 

MyAssistant Designer. 

 

 
  

Note: This step is only available in the MyAssistant Designer by going to File > Options and 

clicking on "Server Settings". It will not be a step when configuring a MyAssistant 

workstation. 

 

Sage User & Password 
In order to monitor information in Sage, MyAssistant needs a user and password in order to 

access that information. To do that, you'll enter the following information in the specified 

fields: 

 

▪ Sage 300 CRE User – Enter the Sage 300 CRE user MyAssistant will use to access 

Sage information  

▪ Sage 300 CRE password – Enter the password associated with the Sage user entered 

 

This Sage user & password is different than what's entered in the Sage 300 Data Folders step 

in that this is the user & password that will be used to run Tasks and access information on 

the server.  

 

Important: Best practices are to use a Sage 300 CRE user with a password that does not 

expire. Also, using an Application Administrator-level Sage user ensures MyAssistant has 

sufficient access to all the Sage information you want it to monitor. 
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Import Sage Database Customizations  

 
MyAssistant automatically imports custom fields and descriptions when monitoring one Sage 

data folder. If MyAssistant is monitoring multiple folders, you will be prompted to select 

which folder’s customizations to import. 

 

Note: Only one Sage folder’s custom fields & descriptions can be in MyAssistant at a time. 

Importing another Sage data folder’s customizations will overwrite previous Sage 

customizations in MyAssistant. 

  

When you create a new custom field or change a field’s description in Sage 300 CRE, you 

must re-run the import process for MyAssistant to recognize the change. 

 

 

Email Settings 

This section lets you update the information MyAssistant needs to send email messages (i.e. 

the outgoing mail server information and/or the "From" email addresses). 

 

Mail Server Settings 

This is the information that must be the same for all email accounts MyAssistant sends 

emails from: 

▪ Outgoing Email Server – Confirm your outgoing server name with your IT/mail 

server administrator 

▪ Outgoing Email Server Port – The port used if the outgoing email server requires a 

port other than 25 

▪ "Use an SSL/TLS connection" checkbox – will be checked if your email server 

requires a secure connection (e.g. a password is required in the grid below) 

 

From Email Account(s) 

These are the accounts MyAssistant will send emails from when running Tasks. This section 

allows you to review & update: 

▪ Default Checkbox – This controls which account MyAssistant sends emails from 

when a "From" email address isn't specified on a Task. 

▪ From Name – This name is displayed in the recipient’s inbox 

▪ Email Address  

▪ User Name – In most cases the user name is the email address. Confirm with your 

email server administrator 

▪ Password 

 

Send Errors To 
Should an error occur and MyAssistant is able to send an email about it, it will send a 

message to the person specified in this section. Best practice is to send error messages to 

whoever has the MyAssistant Designer. 
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Your Settings 
 

 

This step is for entering information about the person using MyAssistant & what additional 

options, if any, they would like to enable. 

 

 

 

As part of the configuration you will fill out the following fields: 

▪ Your Name - The name of the person using MyAssistant 

▪ Your Email Address - Your email address 

 

You'll also check or uncheck boxes for a number of additional settings: 

 

▪ Show Notifications in the Sage 300 Desktop – Controls if activated MyAssistant 

Tasks and their results (called "Notifications") appear in the Sage Desktop software in 

the Applications list 

 

▪ Display MyAssistant Alerts in the System Tray – Controls if MyAssistant appears in 

the Windows System Tray (i.e. the bottom-right section of the Windows task bar next 

to the current date and time) 

 

▪ Show MyAssistant Tile on the Desktop – Controls if the "MyAssistant Live Tile" 

appears on your Windows desktop. The Live Tile is a way to quickly look up 

information in Sage and run Tasks not on schedules without having to open the full 

MyAssistant software. 

 

▪ Send me ideas on using MyAssistant – Controls if you are emailed (at the address 

specified above) new ideas on how to use MyAssistant.  
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MyAssistant Server Configuration 
 

 

MyAssistant has two parts: the MyAssistant Server software and the MyAssistant 

workstation(s). When initially setting up MyAssistant, the first thing installed will be the 

MyAssistant Server software.  

 

After the MyAssistant Server has been installed, it will need to be configured -- this section 

covers the steps involved in configuring the MyAssistant Server for the first time, as well as 

what can be changed after the initial configuration. 

 

Configuring the MyAssistant Server involves the following steps: 

1. Activate the MyAssistant Server 

2. Select which prebuilt “Tasks” (Construction or Real Estate) to use in MyAssistant 

3. Enter the Sage user name and password MyAssistant will use to access Sage 300 CRE 

data 

4. Choose which Sage 300 CRE data folders MyAssistant will monitor 

5. Enter the email address(es) MyAssistant will use to send emails 

6. Specify MyAssistant Server settings 

 

When you configure the MyAssistant Server, you'll start on a "Welcome" screen with a couple 

reminders of what you'll need and an option to show the Advanced Options. 
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MyAssistant Server Activation 
 

 

This step covers activating the MyAssistant Software and any Web Proxy Settings that will be 

used. In this step, you will enter the following information in their respective fields: 

▪ Customer Number: Sage customer number assigned to your company. This can be 

found in the Sage Customer Portal, or by opening a Sage 300 application and clicking 

Help > About [Application Name] 

 

▪ Product Key: The product key for activating the MyAssistant Server. This is the only  

  

 

 
 

 

When configuring the MyAssistant Server, click "Activate" after entering the above 

information. Click "Next" when you see a message on the screen that the software is 

activated. 

  

 

Note: The Web Proxy Server checkbox will only appear if you selected Show Advanced 

Options in the Welcome step. If you use a Web Proxy Server, check the box displayed under 

the Server Product Key field and provide the requested information. 
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MyAssistant Database Connection 
 

 

MyAssistant stores information about your Tasks, Task schedules, Email Directory 

information, copies of attached Crystal Reports and more in its own database. This database 

exists in a type of software called Microsoft SQL Server. This step of the Server Configuration 

is where you name the server where the SQL instance exists, the name of the SQL Server 

instance, and what port number should be used to connect to the database.  

 

If MyAssistant is using the SQL Server instance that is installed as part of a normal 

MyAssistant installation, this information will be prefilled and the step will be skipped in the 

initial MyAssistant Server Configuration. 

 

If the "Show Advanced Options" checkbox is checked on the first step of the MyAssistant 

Server Configuration, or you're using a different instance of SQL Server, you will need to 

confirm/enter the information required in this step. 

 

 
 

 

 

Warning: It is strongly recommended that the information in this step is not changed. 

Changing any information could break the connection between the MyAssistant software 

and its database. 
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MyAssistant Database 
 

 

When initially setting up MyAssistant, you will have the option to select which prebuilt 

MyAssistant Tasks should be set up. It's recommended you choose based on your business 

and what you primarily want to use MyAssistant for, as this selection is permanent and 

cannot be changed.  

  

Check the Documents folder in the MyAssistant install files to see what Tasks are set up with 

each selection.  

 

 
 

Note: This step will only appear when configuring the MyAssistant Server and creating a 

MyAssistant database for the first time. 

 

Click "Next" at the bottom of the window after selecting your prebuilt Tasks. MyAssistant will 

then begin creating its database and advance to the next step when it is ready. 
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Sage Login and Data Folders 
 

 

MyAssistant can monitor and automatically report on multiple Sage data folders, or just one. 

In this step you select which data folders MyAssistant will monitor, as well as the Sage user 

and password MyAssistant will use to access that information. 

  

 
 

Sage User & Password 
In order to monitor information in Sage, MyAssistant needs a user and password in order to 

access that information. To do that, you'll enter the following information in the specified 

fields: 

 

▪ Sage 300 CRE User – Enter the Sage 300 CRE user MyAssistant will use to access 

Sage information  

▪ Sage 300 CRE password – Enter the password associated with the Sage user entered 

  

Important: Best practices are to use a Sage 300 CRE user with a password that does not 

expire. Also, using an Application Administrator-level Sage user ensures MyAssistant has 

sufficient access to all the Sage information you want it to monitor. 

 

If the need should arise, the Sage user & password information can be updated from the 

MyAssistant Designer. To update, open the MyAssistant Designer, click File > Options, and 

select "Server Settings" on the left side of the window that opens. 

 

  

Sage Data Folders  
This controls which Sage data folders MyAssistant can monitor. MyAssistant can only run 

Tasks for data folders in this list. 
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When configuring the MyAssistant Server: Click "Add Folder" and select the first Sage Data 

folder you want to monitor. Repeat as desired until all Sage data folders are added.  

 

Note: If the MyAssistant Server is not on the same computer as the Sage 300 CRE Server, make 

sure the data folder paths are UNC paths (i.e. the paths begin with "\\") and do not use mapped 

drives. 

 

If you need to change which Sage data folders MyAssistant is monitoring after the initial 

configuration, open the MyAssistant Configuration Manager on the server to change the 

data folders being monitored. 

 

 

Import Sage Customizations  

 
MyAssistant automatically imports custom fields and descriptions when monitoring one Sage 

data folder. If MyAssistant is monitoring multiple folders, you will be prompted to select 

which folder’s customizations to import.  

 

 

Note: Only one Sage folder’s custom fields & descriptions can be in MyAssistant at a time. 

Importing another Sage data folder’s customizations will overwrite previous Sage 

customizations in MyAssistant. 

  

When you create a new custom field or change a field’s description in Sage 300 CRE, you 

must re-run the import process for MyAssistant to recognize the change. This can be done 

from inside the MyAssistant Designer by opening the MyAssistant Designer, clicking File > 

Options, and selecting "Server Settings" on the left side of the window that opens. 

 

  



_______________________________________________________________________________________________________________________________________ 

Copyright © 2022 Innovative Software Design 109 

Email Accounts 
 

 

MyAssistant communicates information by sending emails. This step covers the information 

MyAssistant needs to send messages from the desired email account(s).  

 

Note: If this information is not available when configuring the MyAssistant server, you can 

enter it later in the MyAssistant Designer. To update, open the MyAssistant Designer, click 

File > Options, and select "Server Settings" on the left side of the window that opens. 

 

 
 

Outgoing Mail Server 
The following mail server information must be the same for all email addresses that 

MyAssistant will use to send emails: 

 

▪ Outgoing Email Server – Confirm your outgoing server name with your IT/mail 

server administrator. All email addresses entered in this step must use the same 

outgoing mail server.  

▪ Outgoing Email Server Port – Enter the port to use if the outgoing email server 

requires a port other than 25 

▪ Check the box for Use an SSL/TLS connection if your email server requires a secure 

connection. 
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From Email Account(s) 
Companies often want to use MyAssistant to automate or work with multiple aspects of their 

business. As such, a common request is having MyAssistant send emails from different email 

addresses. With MyAssistant, you can send messages from different Email Addresses. 

 

Enter the following information for each Email Address that you want MyAssistant to use: 

▪ Default Checkbox – This controls which account MyAssistant sends emails from 

when a "From" email address isn't specified on a Task. 

▪ From Name – This name is displayed in the recipient’s inbox 

▪ Email Address  

▪ User Name – In most cases the user name is the email address. Confirm with your 

email server administrator 

▪ Password 

 

Important: You may need to configure SMTP relays to allow the MyAssistant Server to send 

email messages. Consult your mail server administrator to confirm your settings and/or 

configure your relays. 

 

 

When configuring the MyAssistant Server, click "Next" when you're ready to proceed to the 

final step. MyAssistant will then test the email settings for every address entered in the grid 

and alert you if there are any errors. 
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Server Options 
 

 

This step covers final options that need to be confirmed for the MyAssistant Server 

Configuration. 

 

 
 

Daily Summaries Time 

Tasks that send a list in an email and have no attachments can be compiled into a once-a-

day "Daily Summary" email sent to recipients. This option controls when Daily Summary 

emails are sent each day (if there are any to send). Please note this time should be after all of 

your Tasks have finished running for the day. 

 

Controlling if a Task's information is included in Daily Summary email is determined in the 

Task Options step of each Task's setup. 

Send Errors To 

Should an error occur and MyAssistant is able to send an email about it, it will send a 

message to the person specified in this section. Best practice is to send error messages to 

whoever has the MyAssistant Designer. 

 

This information can be updated at a later date in the MyAssistant Designer by opening the 

MyAssistant Designer, clicking File > Options, and selecting "Server Settings" on the left side 

of the window that opens. 
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Running Tasks and Sending Service Settings 

MyAssistant runs Tasks and sends emails (i.e. Windows Services) on the server. These 

processes are scalable to increase performance, and can auto-correct if they stop working. 

  

MyAssistant’s Windows Services (named “ISDAdminTaskService” and 

“ISDAdminSenderService”) start other processes named “TaskRunner*32”. Each process uses 

30-50Mb of memory when idle. Many variables affect system resources when Tasks run and 

emails are sent, including: 

▪ The available server memory  

▪ Disk drive performance 

▪ Other server demands at the time the MyAssistant Tasks are run or emails are being 

generated. For example, running Tasks at night may allow MyAssistant to use 

additional server resources. 

  

You can perform the following to determine the optimal number of processes: 

▪ Complete the MyAssistant Server Configuration Wizard with the default settings and 

the MyAssistant Workstation installation. 

▪ Activate two MyAssistant Tasks you will regularly use. 

▪ Monitor the server memory usage and disk queue lengths when the Tasks are run 

concurrently.  

▪ Open the MyAssistant Configuration Manager and increase or decrease the number 

or processes based on the results of this test and available server resources. 

 

 
 


